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What is the Personal Daily PlanIt?

The Personal Daily PlanIt is the first truly multimedia planner of its kind.    Using a variety of 
multimedia technologies including full-motion video, animation, sound, high resolution 
photography and text, it is a planning tool that is utility and entertainment rolled into one.    

You can choose from four intriguing versions that are purchased separately:
PlanIt Adrenaline, with the thrill of sports from Warren Miller Entertainment,
PlanIt Paradise, with the warmth of sunshine from Swimwear Illustrated,
PlanIt Earth, with the beauty of nature from the Art Wolfe.
Rocky Mountain PlanIt, with the rugged wilderness of Canadas Banff National Park.

With the PlanIt, you can:
Tailor the planner sections to your needs.
Schedule meetings, appointments and set alarms to remind you of these events prior to 

their occurrences.
Keep track of things you have to do.
Schedule recurring events.
Record a voice annotation, or a verbal message, to any event.
Store names, telephone numbers, addresses, and other pertinent information in your 

Address Book.
Print information in a variety of formats.

In addition, the PlanIt lets you:
Spice your day with entertainment launchers.
Work with just a mouse and a microphone.
View vivid color photographs every day.
Keep track with the help of a personal assistant.
Capture the experience with full-motion video.

Work with the PlanIt to organize your life, and have fun doing it!
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File New      (Ctrl+N)

Tool Button:    

Creates a new PlanIt database file.

The File New dialog box contains the following options.    When you are finished, click OK to 
open, or click Cancel to quit without creating a new file.

File Name
Displays the file name to create.    Enter the name of the file you want to create.    All files in
the current directory matching your specified extension are listed in the Files box.

Files
Lists all files in the current directory that match the specified extension in the File Type box.

File Type
Displays the file type and its corresponding file extension.    Only the PlanIt v2.0 database 
file extension (*.0da) is available.

Directories
Lists the drives and directories in your system.    To change the current directory displayed, 
click the new directory.



File Open      (Ctrl+O)

Tool Button:    

Opens an existing file.

The File Open dialog box contains the following options.    When you are finished, click OK to 
open, or click Cancel to quit without opening file.

File Name
Displays the filename to open.    Enter the name of the file you want to open.    You can also 
select the filename from the Files box by clicking the Up/Down arrows of the scroll bar and 
clicking the filename that you want to open.    All files in the current directory matching 
your specified extension are listed in the Files box.

Files
Lists all files in the current directory that match the specified extension in the File Type box.

File Type
Displays the file type and its corresponding file extension.    To change the file type 
displayed, click the Down arrow to access a list of file types and click the desired extension.
Only the PlanIt v2.0 and PlanIt v1.0 database file extensions (*.0da and *.0dt, respectively) 
are available.

Directories
Lists the drives and directories in your system.    To change the current directory displayed, 
click the new directory.



File Save      (Ctrl+S)

Saves the current file under its existing name and location.    All changes made to the file will
be saved.        To save the current file with a new name, use the Save As command.



File Save As

Tool Button:    

Saves the active file under a new name that you specify.    To save the current file with its 
existing name, use the Save command.

The File Save As dialog box contains the following options.    When you are finished, click OK 
to save, or click Cancel to quit without saving file.

File Name
Displays the filename.    Enter the new name you want to save the current file to.    To save 
the file to a location other than the current directory, enter the path name or use the 
Directories box.

Files
Lists all files in the current directory that match the specified extension in the File Type box.

File Type
Displays the file type and its corresponding file extension.    To change the file type, click 
the Down arrow to access a list of file types and click the desired extension.    Only the 
PlanIt v2.0 and PlanIt v1.0 database file extensions (*.0da and *.0dt, respectively) are 
available.

Directories
Lists the drives and directories in your system.    To change the current directory displayed, 
click the new directory to save this file to.



File Delete

Deletes a database you specify.

The File Delete dialog box contains the following options.    When you are finished, click OK 
to delete, or click Cancel to quit without deleting a database.    You cant delete the database
currently open.

File Name
Displays the file name to delete.    Enter the name of the file you want to delete.    All files in
the current directory matching your specified extension are listed in the Files box.

Files
Lists all files in the current directory that match the specified extension in the File Type box.

File Type
Displays the file type and its corresponding file extension.    To change the file type 
displayed, click the Down arrow to access a list of file types and click the desired extension.
Only the PlanIt v2.0 and PlanIt v1.0 database file extensions (*.0da and *.0dt, respectively) 
are available.

Directories
Lists the drives and directories in your system.    To change the current directory displayed, 
click the new directory.



File Import

Allows you to import external files into your current PlanIt database file.    You can import 
your PlanIt version 1.0 files, as well as (ASCII, comma separated) text files.    Text files are 
only imported into the address book section.

File Import allows two types of data to be imported: PlanIt v1.0 data files or    Address 
book from text file. Both use the File Import dialog box which contains the following 
options.    When you are finished selecting the file to import from, click OK, or click Cancel 
to quit without opening file.    When importing text files, see the File Import Mapping section 
below.    For instructions, refer To Import Text File.

File Name
Displays the filename to open.    Enter the name of the file you want to open.    You can also 
select the filename from the Files box by clicking the Up/Down arrows of the scroll bar and 
clicking the filename that you want to open.    All files in the current directory matching 
your specified extension are listed in the Files box.

Files
Lists all files in the current directory that match the specified extension in the File Type box.

File Type
Displays the file type and its corresponding file extension.    To change the file type 
displayed, click the Down arrow to access a list of file types and click the desired extension.
Only text (.txt) and CSV files (.csv) are displayed with the Text File type, but you may use 
any extension in the file name box.

Directories
Lists the drives and directories in your system.    To change the current directory displayed, 
click the new directory.

File Import Mapping:

For importing text files, the File Import Mapping dialog box contains the following options.    
When you are finished, click OK to import files, or click Cancel to quit without importing 
files.

Import from
Displays the path and file of the selected text file to import.

Field names as first record
Indicates whether the first record in the text file contains the field names.    If this box is 
checked (contains an X), the text file contains field names as the first record and therefore 
this record should not be imported.

Display:    Data or  Field Names
Radio buttons allow you to display either the text file Data or the Field Names (numbers) 
next to the PlanIt field names in the PlanIt Fields list box.    Note that no text file information
is displayed in the PlanIt Fields list box until fields from the Text File Fields list box are 
mapped to the fields in the PlanIt Fields list box.

Text File Fields



Displays the field numbers and corresponding data from the selected text file.    A scroll bar 
allows you to scroll to fields not displayed.

PlanIt Fields
Displays the PlanIt address book field names and the corresponding text file field names 
that have been mapped to the PlanIt fields.    A scroll bar allows you to scroll to fields not 
displayed.

1st Rec
Displays the first record in the text file in the Text File Fields list box.

Nxt Rec
Displays the next record in the text file in the Text File Fields list box.

Map All
Maps all of the PlanIt Fields to the Text File Fields, where the first text file field is mapped to 
the first PlanIt field, the second text file field is mapped to the second PlanIt field,    and so 
forth until all PlanIt fields have been mapped to one of the text file fields.

Clear
Clears all mappings between the PlanIt fields and the text file fields.

__________
See also

To Import Text File



File Export

Allows you to export your current PlanIt database files into external files.    You can export to 
PlanIt version 1.0 files, as well as (ASCII, comma separated) text files. Only the address book
section is exported to text files.

File Export allows two type of data export: PlanIt v1.0 data files or    Address book to 
text file. Both use the File Export dialog box which contains the following options.    When 
you are finished selecting the export file, click OK, or click Cancel to quit without exporting. 
When exporting to a text file, see the File Export Mapping section below. For instructions, 
refer To Export Text File.

File Name
Displays the filename.    Enter the new name you want to save the current file to.    To save 
the file to a location other than the current directory, enter the path name or use the 
Directories box.

Files
Lists all files in the current directory that match the specified extension in the File Type box.

File Type
Displays the file type and its corresponding file extension.    To change the file type, click 
the Down arrow to access a list of file types and click the desired extension.    Only the 
PlanIt v2.0 and PlanIt v1.0 database file extensions (*.0da and *.0dt, respectively) are 
available.

Directories
Lists the drives and directories in your system.    To change the current directory displayed, 
click the new directory to save this file to.

File Export Mapping:

For exporting to text files, the File Export Mapping dialog box contains the following options.  
When you are finished, click OK to export files, or click Cancel to quit without exporting 
files.

Export to
Displays the path and file of the selected text file to export to.

Field names as first record
Indicates whether the to export the mapped PlanIt field names as the first record in the 
text file. If this box is checked (contains an X), the text file will contain the mapped PlanIt 
field names as the first record.

Display:    Data or  Field Names
Radio buttons allow you to display either the PlanIt Data or the PlanIt Field Names next to 
the text file field numbers in the Text File Fields list box.    Note that no PlanIt data is 
displayed in the Text File Fields list box until fields from the PlanIt Fields list box are mapped
to the fields in the list Text File Fields box.

PlanIt Fields
Displays the PlanIt address book field names and the corresponding PlanIt data. A scroll bar



allows you to scroll to fields not displayed.

Text File Fields
Displays the field numbers and the PlanIt field names (or data depending on the display 
option chosen). A scroll bar allows you to scroll to fields not displayed.

Prv Rec
Displays the previous records data, if any, from the PlanIt address book database in the 
PlanIt Fields list box.

Nxt Rec
Displays the next records data, if any, from the PlanIt address book database in the PlanIt 
Fields list box.

Map All
Maps all of the PlanIt Fields to the Text File Fields, where the first text file field is mapped to 
the first PlanIt field, the second text file field is mapped to the second PlanIt field,    and so 
forth until all PlanIt fields have been mapped to one of the text file fields.

Clear
Clears all mappings between the PlanIt fields and the text file fields.

__________
See also

To Export Text File



File Update Media

Updates the media contents of your PlanIt.

The Update Media dialog box contains the following options.    When you are finished, click 
OK to update your media.    To quit without updating media, click Cancel.

Update Media For
Specifies the month for which the media will be updated.    To specify the month, click the 
Down arrow to access a list of months and click the desired month.

Update Images
Indicates that the current images in your hard disk will be updated.    To update your current
images, click the Update Images check box, and an 'X' will be displayed in the box.    If you 
want to include large images, click the Include Large Images check box.    Images are 
updated only for the current PlanIt image pack.

Update Entertainment
Indicates that your entertainment features will be updated.    To update your entertainment 
features, click the Update Entertainment check box.    Entertainment features are updated 
based upon your current launcher button settings.

__________
See also

To Update Media
Launchers



File Import Photo

Brings in photo from a Photo CD to be used instead of one or more images of your PlanIt.

The Import Photo dialog box contains the following options.    When you are finished, click 
Import to import a photo.    To quit, click Close.    To delete a Photo CD file from the Use As 
section, click the appropriate Use As frequency and click Delete.

PCD Files
Lists all the Photo CD (PCD) files contained in the CD-ROM.    To access files that are not 
currently displayed, click the Up/Down arrows of the scroll bar.    Choose the image that you
want to import into your PlanIt by clicking the desired filename.

CD-ROM Drives
Specifies the CD-ROM drive in which you have your Photo CD.    To access a list of the CD-
ROM drives in your system, click the Down arrow.    Select your CD-ROM drive by clicking 
the drive from the list.

Preview
Displays the image you select for preview.    To view an image before you actually import 
the photo, click the Preview toggle button.    An 'X' in the Preview toggle button will bring up
the image you selected onto the Preview box.

Use As...
Specifies the purpose for which you are importing the photo.    You can use the photo you 
import to replace the image for a Generic Day (the same day each month), Specific Day (a 
specific month and day), Month, or Year.    You can enter any one of these options by 
entering the first letter of the option, or by clicking the Down arrow and clicking the desired
option.
If you choose to use the photo you import as the image for a Generic Day, specify the day 
by clicking the corresponding day icon of the particular day you want.    The day icons are 
numbered from 1 to 31, and are displayed below the Use As box.
If you choose to use the photo for a Specific Day, specify the month by clicking the 
Left/Right arrows beside the month text until you come upon the month you want.    On the 
day icons, click the corresponding day icon of the specific day that you want to use the 
photo you import.
If you choose to use the photo you import for a Month, select the specific month by clicking
the corresponding month icon that is displayed below the Use As box.

__________
See also

To Import Photo



File Print      (Ctrl+P)

Tool Button:    

Prints information from your PlanIt.    You can specify the page layout, which section of the 
PlanIt to print and which printer to use.    In addition, you may specify how many copies to 
print and the information data range to include.

The File Print dialog box contains the following options.    When you are finished, click OK to 
print.    To see on the screen how your output will look before you actually print it, click 
Preview.    To quit without printing, click Close.

Layout
Specifies the page layout of the output based on a pre- and user-defined list.    The page 
layouts are defined using the Page Setup command from the File menu.    To change the 
page layout, click the Down arrow to access a list of available page layouts, and choose the
desired layout. Numbers in parenthesis for label  orientations indicate the corresponding 
Avery    Dennison Laser Product part number(s).

Section
Indicates the type of output to print.    To select a different section, click the Down arrow to 
access a list of output types, and click the desired section to print.    The available sections 
are:

Planner
ToDo List
Address Book
Location List

Note that for label and envelope layouts, only the Address Book section is available.

Printer
Specifies the printer to use.    To change the printer, click the Down arrow to access a list of 
installed printers, and choose the printer to use.    

Copies
Indicates the number of copies to print.    To specify a different number, click the Up/Down 
arrow to change the number of copies to print.

Range Selection
Indicates whether to print all the information for the section to be printed, or just a certain 
range.    For the Planner and ToDo List sections, Next 7 Days prints information of all 
upcoming events for the next 7 days.    Next 30 Days prints information of all events for the
next 30 days.    From/To specifies the date range of the events to print.    For the Address 
Book and Location List sections, All Entries will print all the entries in the Address Book or 
Location file.    From/To specifies the alphabetical range of the entries to print.
Date Range

The default date displayed in the From and To boxes is the current planner date.    To 
change the range of dates to print, click the Up/Down buttons in the From and To boxes 
to select the dates.    You can also change the From and To dates by clicking the Goto 
Date icon, , to the right of the From and To boxes.    
Note    The date set in the To box cannot be earlier than the date set in the From box.



Alphabetical Range
The default records in the From and To boxes are the first and the last records in your 
Address Book for your Address Book, or the first and the last records in your Location file
for the Location List.    To change the range of names to print, click the Up/Down buttons 
to select the names in the From and To boxes.
Note    The name set in the To box cannot be alphabetically earlier than the name set in 
the From box.

Preview
Use the Preview button to view on the screen how your output will look before you actually 
print it.    Preview allows you to page through (Prev Page, Next Page) your output.    You 
may Zoom In (or Zoom Out) to enlarge the output view.    You may also view two pages at
a time by clicking Two Page.    Click Print to print the output; click Close to quit without 
printing.

Page
Use the Page button to change the page settings of the output.    The Page Setup dialog will
be accessed. 

Options
Use the Options button to select which information to include in each of the sections to be 
printed.    The Print Options dialog will be accessed.

__________
See also

To Maintain Locations
To Manage Address Book Entries
To Print from Your PlanIt
To Set the Date for an Event
To Set Up Page Settings to Print
To Set Up Print Options



File Page Setup

Creates or edits the page settings used to print information.    You can choose from a pre-
defined list of page layouts, edit a layout from the list, or create a new layout.    A page 
layout for the print output can be customized by setting the size, orientation, margins, and 
font.

The File Page Setup dialog box contains the following options.    When you are finished, click 
OK to accept page setup, or click Cancel to quit without editing page settings.    To delete 
the current page setup, click Delete.

Layout
Indicates the paper layout of the output.    To select a different layout, click the Down arrow 
to access a list of page layouts, and click the desired paper layout.    To create a new layout,
type the new page layout title in the box. Numbers in parenthesis for label  orientations 
indicate the corresponding Avery    Dennison Laser Product part number(s).

Orientation
Specifies the paper orientation to use.    To select the paper orientation, click one of the four
available orientations:

Portrait 
Landscape
Labels
Envelope

Note: Labels orientation cannot be selected but rather indicates when you have selected
a pre-defined label oriented layout.

Margins
Specify the top, bottom, left, and right margins of the output.    To set the margins, click the 
Up/Down buttons in each of the top, bottom, left, and right boxes to increase or decrease 
the margins in increments of 0.1 inch.    Margins may not be edited for Label orientations.

Page Width
Specifies the paper width in inches.    To set the paper width, click the Up/Down buttons to 
increase or decrease the width in increments of 0.1 inch. Page Width may not be edited for 
Label orientations.

Page Height
Specifies the paper height in inches.    To set the paper height, click the Up/Down buttons to
increase or decrease the height in increments of 0.1 inch.    Page Height may not be edited 
for Label orientations.

Font
Selects the font to use on the printed output.    The font types shown are those that are 
available for the currently selected printer.    To change the font type, click the Down arrow 
to access the list of available font types for the selected printer and click the font to use. 

Font Sizes
Specify the font sizes for the page heading, title, and text to be printed.    To change the 
font sizes for the printed output, click the Up/Down buttons of the corresponding page 
heading, title, and text font settings to increase or decrease the font sizes.



Page Heading is specified in the Print Options and is printed centered at the top of each
page.    Page Heading font size and style is not used when printing label or envelope 
orientations.

Title refers to the date line when printing Planner or ToDo List sections. Title refers to 
the first line (Name or Company) when printing Address Book sections.

Text refers all information not printed as Heading or Title; this is the event information 
after the date line when printing Planner or ToDo List sections and the information after 
the first line (Name or Company) when printing the Address Book section and all Location
information.

Font Styles
Specify the font styles for the page heading and title to be printed.    To select the font 
styles, click one of the 3 font styles available for the page heading and title to be printed:

Bold 
Italics
Underline 

You can use any combination of these styles.

Return Address
For Envelope oriented layouts, you may enter a return address to be printed in the top left 
corner of the envelope.    This Return Address is PlanIt specific - it remains constant for all 
Envelope layouts.    Click the Omit Return Address check box,    to place an X in the box, 
to print the return address on each envelope.    Click the check box again to remove the X 
and not print the return address on each envelope.

__________
See also

To Configure Page Settings to Print
To Print from Your PlanIt



File Print Options

Specifies the information to be included on the output for the print sections:
Planner
Address Book
ToDo List

When you are finished, click OK to accept the print options, or click Cancel to quit without 
changing the print options.

__________
See also

To Print from Your PlanIt
To Set Up Print Options



File Exit

Quits your PlanIt and closes the PlanIt window.



Print Options - Planner

The Planner section of the File Print Options dialog box contains the following options.

Heading
The page heading to be used for the printout is specified in the text box at top of the 
Planner Print Options section.    To print a page heading, type in the desired text in the 
Heading box.    Page headings are printed at the top center of each page.

Events
Indicates the events to be included in the Planner printout.    To include an event type in the
printout, click the box of the appropriate event type. The types of events available for the 
Planner printout are:

Timed Events
Day Events
ToDo Events

Detail
Sets the level of detail to be included in the printout of each event.    To select the level of 
detail, click either All or # Lines button for that event.    

All includes all event information in the Planner printout.    

The # Lines sets the number of lines to be printed for each event.    To change the number 
of lines per event, click the Up/Down buttons to increase or decrease the number of lines in
increments of 1.

__________
See also

To Print from Your PlanIt
To Set Up Print Options



Print Options - Address Book

The Address section of the File Print Options dialog box contains the following options.    

Heading
The page heading to be used for the printout is specified in the text box at top of the 
Address Book Print Options section.    To print a page heading, type in the desired text in 
the Heading box. Page headings are printed at the top center of each page.

Print
Indicates the address information to be included in the Address Book and Address Label 
printouts.    To select which information to include, click the boxes next to the desired 
information.    The information available are:

Title
First Name
Last Name
Position
Company
Address
Telephone
Fax
User defined field 1
User defined field 2
Notes

For Notes,    the level of detail to be printed can be specified.    To select the level of detail to
print, click either All or # Lines button.    All includes all Notes.    The # Lines sets the 
number of lines to be printed for the Notes in the Address Book printout.    To change the 
number of lines, click the Up/Down buttons to increase or decrease the number of lines in 
increments of 1.

Sort By
Indicates whether the output is to be sorted by Name or by Company.    To sort by name, 
click the radio button labeled Name. To sort by company, click the radio button labeled 
Company.

__________
See also

To Print from Your PlanIt
To Set Up Print Options



Print Options - ToDo List

The ToDo section of the File Print Options dialog box contains the following options.

Heading
The page heading to be used for the printout is specified in the text box at top of the ToDo 
list Print Options section.    To print a page heading, type in the desired text in the Heading 
box. Page headings are printed at the top center of each page.

ToDo Event Types
Indicates whether to include the Completed and/or Canceled ToDo events in addition to the
open (scheduled) ToDo events in the ToDo list.    To include completed ToDo events in the 
list, click the Completed ToDo Events box.    To include canceled ToDo events in the list, click
the Canceled ToDo Events box.

Detail
Sets the level of detail to include in the ToDo list.    To select the level of detail, click either 
All or # Lines button.

The All includes all event information.    

The # Lines sets the number of lines for each event to be printed in the ToDo list.    To 
change the number of lines, click the Up/Down buttons to increase or decrease the number
of lines in increments of one.

__________
See also

To Print from Your PlanIt
To Set Up Print Options



Edit Cut      (Ctrl+X)

Tool Button:      

Removes the selected event or address and puts it on the Windows Clipboard.    Click on an 
event or address to select it (it will then be highlighted), then click the Cut tool button. Edit 
Cut is also available from the Edit menu.    The contents previously stored in the Windows 
Clipboard will be replaced by the selected event.



Edit Copy      (Ctrl+C)

Tool Button:      

Copies the selected event or address onto the Windows Clipboard. Click on an event or 
address to select it (it will then be highlighted), then click the Copy tool button. Edit Copy is 
also available from the Edit menu.    The contents previously stored in the Windows Clipboard
will be replaced by the selected event.



Edit Paste      (Ctrl+V)

Tool Button:      

Inserts a copy of the contents stored in the Windows Clipboard at the cursor point. For 
events, click on the desired dateline, then click the Paste tool button; for address entries, 
just click paste when you are in an address tab section.    Edit Paste is also available from the
Edit menu.    This command is not available if the clipboard is empty.



Edit Delete      (Del)

Tool Button:      

Deletes the selected event or address book entry without saving it to the Windows 
Clipboard.    Click on an event or address to select it (it will then be highlighted), then click 
the Delete tool button. Edit Delete is also available from the Edit menu.    The contents 
previously stored in the Windows Clipboard will be replaced by the selected event.



Edit Purge Events

Removes all events that have been scheduled, as well as the voice annotation files that have
been recorded to these events, prior to a date that you specify.

The Purge Events dialog box contains the following options.    When you are finished, click 
OK to purge the events prior to the specified date to provide additional disk space, or click 
Cancel to quit without purging files.

All Events
To remove all events and voice annotation files prior to a date you specify, click the All 
Events button.    Click the button again if you do not want to purge all events prior to the 
specified date.

Completed/Canceled
To delete events (Timed or ToDo) that have been completed and canceled, as well as their 
corresponding voice annotation files, click the Completed/Canceled radio button.    Events 
that have not been completed or canceled will remain on your system.    Click the button 
again if you do not want to purge the completed and canceled files.

Voice Files Only
To remove only voice annotation files associated with events prior to a date you specify, 
click the Voice Files Only button.    All the event files will not be purged from your system.    
Click the button again if you do not want to delete any of the voice annotation files.

Remove Before
Specifies the date prior to which the events that have been scheduled, as well as 
corresponding voice annotation files, will be purged from your system.    To specify the 
purge date, click the desired date in the Standard Calendar dialog's monthly calendar 
section.

__________
See also

To Purge Events and Voice Files
To Navigate with Goto Commands
To Set the Date for an Event



Edit Date/Time

Changes your PlanIt system date and time.    The PlanIt system date is the date today.

__________
See also

To Change System Date and Time
To Navigate with Goto Commands
To Set the Date for an Event



Insert Timed Event

Tool Button:      

Creates an event that requires a beginning and ending time of day.    This command is 
equivalent to clicking the , or the New Timed Event icon, on the dateline of the event 
planner page.    Double-clicking any white space below the events that you have scheduled 
in the Timed event area of a planner page also allows you to insert a Timed event.

The Timed Event dialog box contains the following options.    When you are finished, click OK
to accept the schedule for the Timed event, or click Cancel to quit without saving schedule.

Event Date
Specifies the starting date of the Timed event.    The default event date displayed is the 
current date for which you are scheduling an event.    A Timed event can be scheduled on 
any given date and time.    To schedule the date of the event, click the Left/Right buttons to 
change the event date displayed in the box, one day at a time.    You can also change this 
date through the Standard Calendar dialog by clicking the , or the Date/Time icon.

Start Time
Specifies the starting time of the Timed event.    The default event start time is set in the 
Defaults of the Options menu.    You can schedule the start time of the event by using either
this Event Start Time box or the Time Bar.    To set a time different from the display, click 
the Left/Right buttons to change the time, in increments of 5 minutes.    You can also 
change this time through the Standard Clock dialog by clicking the , or the Date/Time 
icon.    The Start Time selected is reflected in the Time Bar.

Duration
Specifies the duration, in hours and minutes, of the event.    The default Timed event 
duration is set in the Defaults of the Options menu.    You can modify the duration displayed
by clicking the Up/Down buttons.    Each click represents a duration increment of 5 minutes.
You can also use the Time Bar to set the event duration.    The event duration you specify is 
reflected in the Time Bar.    

Time Bar
Provides a drag and drop interface on a scrollable 7-hour ruled bar with incremental scales 
of intervals in 5, 15, 30, and 60 minutes.    It contains scroll arrows, start time, duration, and
end time markers to be used to schedule the Timed event.    The selected start time and 
duration are reflected in the Start Time and Duration boxes located above the Time Bar.

Note    Timed events that have been scheduled are indicated on the Time Bar with a solid 
blue line ( ).    Any attempt to schedule subsequent Timed events within the duration 
indicated will activate the Conflict warning button 
.

Scroll Arrows
The Left/Right arrows are used to scroll the Time Bar to determine the 7-hour range to 
be displayed.    To view a range different from the 7 hours displayed, click one of the 
scroll arrows at either end of the Time Bar.

Start Time



A drag and drop box that allows selection of the start time of a Timed event.    The start 
time and consequently, the duration, is adjusted by keeping the end time constant.    To 
schedule the start time of the event, click the Start marker, drag it to the time desired 
and drop the marker.    While the Start marker is being dragged, the other marker, which 
is the End marker, remains anchored.    This allows the duration to be changed.    

Duration
A drag and drop box that connects the Start Time and End Time boxes.    The start time 
and the end time scheduled for a Timed event can be changed by keeping the duration 
constant.    To move the entire event to a new time while keeping the duration constant, 
click and drag the center marker, or Duration marker, until the Start marker reaches the 
desired start time and drop the marker.    When the duration marker is moved, the entire 
Start-Duration-End marker system is moved.

End Time
A drag and drop box that allows you to select of the end time of a Timed event.    The 
end time and consequently, the duration, are adjusted by keeping the start time 
constant.    To schedule an event end time, click the End marker, drag it to the time 
desired and drop the marker.    While the End marker is being dragged, the other marker,
which is the Start marker, remains anchored.    This allows the duration to be changed.

Scale
A ruled bar similar to a 7-inch ruler.    The smallest ticks denote 5-minute intervals, the 
next larger size denote 15-minute intervals, the next denote 30-minute intervals, and 
the largest ticks denote 1-hour intervals.    All the 1-hour intervals displayed are labeled 
accordingly.    For example, 11:00 am.    If you attempt to drag the entire Start-Duration-
End marker system past one end of the scale, the marker system will stop at that end 
and the scale will continue to scroll in the opposite direction.

Event Icons
Displays 2 rows and 7 columns of Timed event icons.    The default Timed event icons 
displayed are specified in the Defaults of the Options menu.    Each one of the Timed event 
icons has a corresponding event name, and each icon represents a Timed event that can 
be scheduled on a given date and time.    To select a Timed event to schedule, click the 
event icon, or click and drag that event icon onto the Event box located on the lower left 
corner of the dialog.

Event Box
Indicates the Timed event selected.    When you select an event, its corresponding event 
name is automatically displayed in the Event Name box.

Priority
Specifies the priority you want to give the event.    The default priority of a Timed event is 
set in the Defaults of the Options menu.    To assign an event priority different from the 
priority displayed, click the Priority button to cycle through the available priorities of 1, 2, 
or 3.

Status
Specifies the current status of the event.    To indicate the progress of the event, click the 
Status button to cycle through Scheduled (  ), Completed (
), or Canceled (
).

Conflict
Indicates with a warning light conflict with another scheduled Timed event.    The Conflict 



warning button, , becomes active, 
, when an attempt is made to schedule 2 or more Timed events at the same time.        To 

view these conflicting events, click the active Conflict warning button, or 
, and a list of Timed events that have been scheduled will be displayed on the screen.    To 

return to the Timed Event dialog, click the Close button.

Event Name
Displays the name associated with an event icon.    Default event names are set up in the 
Defaults of the Options menu.    The event name is automatically displayed when you click 
a Timed event icon, or when you drag and drop an event icon onto the Event box.    You 
can, however, edit this text.

Event Description Notes
Displays the event notes associated with an event icon.    You can enter description notes 
associated with the event to be scheduled by typing the text in the box.    Click the 
Up/Down arrows of the scroll bar to view text that are not displayed.

Event With
Specifies the person that will participate in the Timed event.    To select the person that will 
be needed for the event, click the Down arrow to access a list of all the names taken from 
the Address Book and click the name of the person.    You can also manually enter a name 
of up to 51 characters in this box.    To add this entry to your Address Book, click the button 
to the left of the Event With box, and the Address Book dialog will be accessed.

Event Location
Indicates the location of the Timed event.    To select the event location, click the Down 
arrow to access a list of available locations and click your choice.    The locations displayed 
on the list are set up in the Locations of the Options menu.    You can also enter the location
manually.    To add this location to your Locations list, click the button to the left of the 
Event Location box, and the Locations dialog will be accessed.

Voice
Use the Voice button to record a voice annotation to the event.    The Voice Annotation 
dialog will be accessed. 

Alarm
Use the Alarm button to set an alarm to provide a reminder of this event.    The Alarm 
dialog will be accessed. 

Recur
Use the Recur button to schedule this event as a recurring event.    The Recur Event dialog 
will be accessed.

__________
See also

To Maintain Locations
To Manage Address Book Entries
To Schedule Timed Events
To Set the Date for an Event
To Set the Defaults for Timed Events
To Set the Start Time for an Event
To Use the Time Bar



Insert ToDo Event

Tool Button:      

Creates an action item, or a ToDo event.    This command is equivalent to clicking the , or 
the New ToDo Event icon, on the dateline of the event planner page.    Double-clicking any 
white space below the events that you have scheduled in the ToDo event area of a planner 
page also allows you to insert a ToDo event. 

The ToDo Event dialog box contains the following options.    When you are finished, click OK 
to accept the schedule for the ToDo event, or click Cancel to quit without saving schedule.

Event Icons
Displays 2 rows and 7 columns of ToDo event icons.    The default ToDo event icons 
displayed are specified in the Defaults of the Options menu.    Each one of the ToDo event 
icons has a corresponding event name, and each icon represents a ToDo event that can be 
scheduled on a given date.    To select a ToDo event to schedule, click the event icon, drag 
and drop that icon onto a date in the Standard Calendar dialog's monthly calendar section.

Priority
Specifies the priority you want to give the event.    The default priority of a ToDo event is 
set in the Defaults of the Options menu.    To assign an event priority different from the 
priority displayed, click the Priority button to cycle through the available priorities of 1, 2, 
or 3.

Status
Specifies the current status of the event.    To indicate the progress of the ToDo event, click 
the Status button to cycle through Scheduled (  ), Completed (

), or Canceled (
).

Duration
Specifies the duration, in number of days, of the event.    The default duration of a ToDo 
event is set in the Defaults of the Options menu.    You can modify the duration displayed by
clicking the Up/Down buttons.    Each click represents a duration increment of 1 day.    

Event Name
Displays the name associated with an event icon.    Default event names are set up in the 
Defaults of the Options menu.    The event name is automatically displayed when you click 
a ToDo event icon and drag it onto a given day in the Standard Calendar.    You can, 
however, edit this text.

Event Description Notes
Displays the event notes associated with an event icon.    You can enter event description 
notes associated with the event to be scheduled by typing the text in the box.    Click the 
Up/Down arrows of the scroll bar to view text that are not displayed.

Voice
Use the Voice button to record a voice annotation to the event.    The Voice Annotation 
dialog will be accessed. 

Alarm
Use the Alarm button to set an alarm to provide a reminder of this event.    The Alarm 



dialog will be accessed. 

__________
See also

To Schedule ToDo Events
To Set the Date for an Event
To Set the Defaults for ToDo Events



Insert Day Event

Tool Button:      

Creates an event that utilizes an all day format.    This can be used to schedule vacation, 
holidays, special days or any event that is not time sensitive.    This command is equivalent 
to clicking the , or the New Day Event icon, on the dateline of the event planner page.    
Double-clicking any white space below the events that you have scheduled in the Day event 
area of a planner page also allows you to insert a Day event.    

The Day Event dialog box contains the following options.    When you are finished, click OK to
accept the schedule for the Day event, or click Cancel to quit without saving schedule.

Event Icons
Displays 2 rows and 7 columns of Day event icons.    The default Day event icons displayed 
are set in the Defaults of the Options menu.    Each one of the event icons has a 
corresponding event name, and each icon represents a Day event that can be scheduled 
on a given day.    To schedule a Day event, click an event icon and drag that icon onto a 
given day in the Standard Calendar dialog's monthly calendar section.    

Duration
Specifies the duration, in number of days, of the event.    The default duration of a Day 
event is set in the Defaults of the Options menu.    You can modify the duration displayed by
clicking the Up/Down buttons.    Each click represents a duration increment of 1 day.    

Event Name
Displays the name associated with an event icon.    Default event names are set up in the 
Defaults of the Options menu.    The event name is automatically displayed when you click 
a Day event icon and drag it onto a given day in the Standard Calendar.    You can, 
however, edit this text.

Event Description Notes
Displays the event notes associated with an event icon.    You can enter event description 
notes associated with the event to be scheduled by typing the text in the box.    Click the 
Up/Down arrows of the scroll bar to view text that are not displayed.

Voice
Use the Voice button to record a voice annotation to the event.    The Voice Annotation 
dialog will be accessed. 

Alarm
Use the Alarm button to set an alarm to provide a reminder of this event.    The Alarm 
dialog will be accessed. 

Recur
Use the Recur button to schedule this event as a recurring event.    The Recur Event dialog 
will be accessed.

__________
See also

To Schedule Day Events
To Set the Date for an Event



To Set the Defaults for Day Events



Insert Address Entry

Tool Button:      

Creates an entry in the Address Book.    This command is equivalent to clicking any white 
space outside of an entry in the Address Book.

The Address Book dialog box contains the following options.    When you are finished, click 
OK to accept entry, or click Cancel to quit without saving entry.    Click Blank to clear all 
data entry fields currently displayed.    To delete the current entry displayed, click Delete.

Title
Specifies the title of the person.    To select a person's title, click the Down arrow to access a
list of available titles and then click the desired title from the list.    The available titles are:

Mr.
Mrs.
Ms.
Dr.

You can also type in the person's title; however, you can leave the title blank if no title is 
necessary. 

First Name
Indicates the first name of the person.    You can type in the person's first name.

Last Name
Indicates the last name of the person.    You can type in the person's last name.

Position
Indicates the position of the person.    You can type in the person's position.

Company
Specifies the company represented by the person.    You can type in the person's company 
name.

Note: After typing in the company and tabbing to go to the next field, the PlanIt will 
automatically search for similar companies;    if any similar companies are found, the PlanIt 
will prompt you with a list of the matches.    You may click on one of these entries to copy 
the telphone, fax and address fields to the current record.

Telephone
Specifies the telephone number of the person.    You can type in the person's telephone 
number. 

Fax
Specifies the facsimile number, if any, of the person.    You can type in the person's 
facsimile number.

Address
Shows the address information of the person.    You can enter address information, such as 
street, city, state, and zip code in this box.    Use the scroll bar to view text that are not 
displayed.



User 1
Displays the information in the first user-defined field for this Address Book entry.    The title
of this user-defined field is set in the Defaults of the Options menu.    You can type in text 
for this entry.

User 2
Displays the information in the second user-defined field for this Address Book entry.    The 
title of this user-defined field is set in the Defaults of the Options menu.    You can type in 
text for this entry.

Notes
Displays the notes entered with the entry.    You can enter personal notes about this 
Address Book entry in this box.    Use the scroll bar to view text that are not displayed. 

__________
See also

To Manage Address Book Entries
To Set the Defaults for Address Book



View Planner

Displays the planner section you choose.    Each of the 6 tabbed planner sections will be 
displayed according to how you customize the particular section in the Preferences of the 
Options menu.    A check mark appears next to the tab section that is currently displayed.    
This command is equivalent to clicking any of the tabbed dividers of the section you want to 
go to.

__________
See also

To Customize Tab Preferences
To Navigate With Tabs



View Month      (Ctrl+M) 

Tool Button:      

Displays a calendar for the current month, with the date today    highlighted in blue.    

To view a different month, click the Left/Right buttons on either side of the month display.    
To view the month in a different year, click the Left/Right buttons on either side of the year 
display.    The calendar will display the month you specify in the year you choose.

You can click any date in the calendar and you will be taken to that date in your planner.    
Click the year and the yearly calendar will be displayed on your screen.    To return to where 
you left off in your PlanIt, click any part of the image displayed on your screen.



View Year      (Ctrl+Y)

Tool Button:      

Displays a calendar for the current year, with the date today    highlighted in blue.    January 
to June are displayed on the left side of the screen, and July to December on the right side.

To display a calendar for a different year, click the Left/Right buttons on either side of the 
year display.    The calendar will display the year that you specify.

You can click any date in the calendar and you will be taken to that date in your planner.    
Click any of the month text and the corresponding monthly calendar will be displayed on 
your screen.    To return to where you left off in your PlanIt, click any part of the image 
displayed on your screen.



Maximize Planner

Tool Button:      

Displays your PlanIt window in maximized mode.    The planner, with the 12 Tool Buttons 
lined above it, expands to fill the entire window.    The Media Box and Launchers are not 
displayed.    A check mark appears next to the Maximize Planner menu command.

To return to normal view, click the .

__________
See also

To Configure Tool Buttons



Normal Planner

Tool Button:      

Restores and displays your PlanIt in normal mode.    The Media Box, Launchers and Tool 
Buttons are displayed on the upper half, and the planner on the lower half of the window.    A
check mark appears next to the Normal Planner menu command.

__________
See also

To Configure Launchers
To Configure Tool Buttons
To Launch Programs and Entertainment



Goto Date      (Ctrl+G)

Tool Button:      

Takes you to the date you specify using the Standard Calendar dialog.

__________
See also

To Navigate with Goto Commands



Goto Today      (Ctrl+T)

Tool Button:      

Goes directly to today's date.    In the planner sections that display more than one day, the 
date today    will be highlighted in blue.

The date today    is the system date of your PlanIt.    To change the date today,    choose Edit 
Date/Time from the Edit menu.

__________
See also

To Navigate with Goto Commands



Current Date/Time

Displays, and hides, the current system date and time in the media box area of your PlanIt.    
A check mark appears next to the Current Date/Time menu command when the date and 
time are displayed.



Defaults

Sets the values that will be used as defaults in each of these dialog boxes:
Timed Events
ToDo Events
Day Events
Address Book

__________
See also

To Manage Address Book Entries
To Schedule Day Events
To Schedule Timed Events
To Schedule ToDo Events



Preferences

Allows you to set preferences for your PlanIt.    To configure the preferences for a given 
section, click within the corresponding section of the mock PlanIt.

The Options - Preferences dialog box contains the following options.    When you are finished,
click OK to accept the preferences, or click Cancel to quit without changing preferences.

Mock Launchers Section:    Launchers
Sets preferences for the 9 Program and Entertainment Launchers.    To configure your 
preferences for the program and entertainment launchers, click the launchers section of 
the mock PlanIt.

Mock Tool Buttons Section:    Tool Buttons
Sets preferences for the 12 Tool Buttons.    To configure your preferences for the tool 
buttons, click the tool buttons section of the mock PlanIt.

Mock Planner Section:    Planner Tabs
Sets preferences for each of the 6 tabbed sections in your PlanIt.    To customize a tabbed 
section, click any one of the tabs of the mock PlanIt.

__________
See also

To Configure Launchers
To Configure Tool Buttons
To Customize Tab Preferences



Personal Assistant

Specifies the Personal Assistant that will help you keep track in your PlanIt.

The Personal Assistant dialog box contains the following options.    When you are finished, 
click Close to quit the dialog box.

Installed Media Clips
Lists the media clips that you have installed.    Click the Up/Down arrows on the scroll bar to
view and select media clips that are not currently displayed.

If the clip you want to use is not listed in the Installed Media Clips box, you have to add it to
your PlanIt directory.

Title
Displays the text title of the media file.    You can type in the text title of the media file for 
your reference.

PlanIt Start
To play the clip when you start your PlanIt, click the PlanIt Start check box.    An 'X' in the 
check box indicates that the clip selected will be played in the media box when you initially
start your PlanIt.    Click the check box again if you do not want to play the clip during the 
start up of your PlanIt.

PlanIt Exit
To play the clip when you quit your PlanIt, click the PlanIt Exit check box.    An 'X' in the 
check box indicates that the clip selected will be played in the media box when you exit 
your PlanIt.    Click the check box again if you do not want the clip to be played when you 
exit your PlanIt.

Lunch
To assign the clip as your lunch reminder, click the Lunch check box.    An 'X' in the check 
box indicates the assignment of the selected clip to the your lunch hour, the time of which 
is specified in the Lunch Time box.    Click the check box again if you do not want to use the
clip as your lunch reminder.

Lunch Time
Specifies the default time for the Lunch option.    The default time displayed is 12:00 pm.    
To change the time, click the Up/Down buttons to increase or decrease the time, in 
increments of 5 minutes.

Preview
Use the Preview Button to view the media clip that you have selected from the list of 
installed media clips.    You can view the media clip in the media box.

Note    Full-motion video is available only with the CD-ROM version of the Personal Daily 
PlanIt.

Add
If the clip you want to use is not listed in the Installed Media Clips box, you have to add it to
your PlanIt directory.    Use the Add button to add a media file to the list of installed media 
clips



Delete
Use the Delete button to take off the media file that you have selected from the list of 
installed media clips.

__________
See also

To Add a Media Clip
To Choose Personal Assistants



MediaPack

Displays the media/image packs of the Personal Daily PlanIt that you have available on your 
system:

PlanIt Adrenaline, with the thrill of sports from Warren Miller Entertainment
PlanIt Paradise, with the warmth of sunshine from Swimwear Illustrated
PlanIt Earth, with the beauty of nature from the Art Wolfe
Rocky Mountain PlanIt, with the rugged wilderness of Canadas Banff National Park.

__________
See also

What is the Personal Daily PlanIt?



Locations

Lets you update and maintain your locations file for the scheduling of Timed events.

The Locations dialog box contains the following options.    When you are finished, click Close 
to quit the Locations dialog box.

Location
Specifies the location that you want to add to the current locations file.    To add a location, 
type in the location name or description of up to a maximum of 30 characters, and click the
Add button.

Locations List
Lists the locations that you currently have in your file.    Click the Up/Down arrows of the 
scroll bar to view locations that are not displayed.    To delete a location, click to highlight 
the location and click the Delete button.

__________
See also

To Maintain locations
To Schedule Timed Events



Minimize on Use

Reduces your PlanIt to an icon as soon as it starts, or when launching external programs.



Help Contents

Provides an overview of the contents of the Personal Daily PlanIt Help.    To view a topic, click 
the name of the topic, or press TAB to move to the topic you want and press ENTER.

You will be returned to this screen whenever you click the Contents button in the PlanIt Help 
window.

__________
See also

Personal Daily PlanIt Help Contents



Search for Help on...

Allows you to search for topics in the Personal Daily PlanIt Help.

The Help Search dialog box contains the following options.    When you are finished, click Go 
To to display the selected Help topic, or click Cancel to quit without searching for a topic.

Keyword
Specifies the Help topic to search.    Type a keyword of the Help topic you want to search, or
select one from the list, and click the Show Topics button.

Topics
Lists all the Help topics that are related to the keyword you enter.    Select a Help topic from
the list, and click the Go To button to display the Help topic.

__________
See also

Personal Daily PlanIt Help Contents



Menu Commands

Lists the menu commands in your PlanIt and provides information about each of the 
commands.

__________
See also

Menu Commands



How To...

Displays a list of the tasks in your PlanIt and provides procedures for each of the tasks.

__________
See also

How To ...



PlanIt Quick Tour

Provides a quick preview and demonstration of the features in your Personal Daily PlanIt.    
The video quick tour is run from the CD-ROM by double-clicking the PlanIt Quick Tour icon 
in the Personal Daily PlanIt group.

__________
See also

Personal Daily PlanIt Help Contents



About the PlanIt

Displays product and copyright information about your PlanIt.

__________
See also

What is the Daily PlanIt?



Menu Commands

File Menu
New
Open
Save
Save As
Delete
Import
Export
Update Media
Import Photo
Print
Page Setup
Print Options
Exit

Edit Menu
Cut
Copy
Paste
Delete
Purge Events
Edit Date/Time

Insert Menu
Timed Event
ToDo Event
Day Event
Address Entry

View Menu
Planner
Month
Year
Maximize Planner
Normal Planner
Goto Date
Goto Today
Current Date/Time

Options Menu
Defaults
Preferences
Personal Assistant
MediaPack
Locations
Minimize on Use



Help Menu
Contents
Search for Help on...
Menu Commands
How to...
About the PlanIt



How To ...

Change System Date and Time
Choose Personal Assistants
Configure Launchers
Configure Page Settings
Configure Tool Buttons
Customize Tab Preferences
Export to a Text File
Import a Text File
Import Photo
Launch Programs and Entertainment
Maintain Locations
Manage Address Book Entries
Navigate Your PlanIt
Print from Your PlanIt
Purge Events and Voice Files
Record Voice Annotation to an Event
Schedule Day Events
Schedule Recurring Events
Schedule Timed Events
Schedule To Do Events
Set the Alarm of an Event
Set the Date for an Event
Set the Defaults for Address Book
Set the Defaults for Day Events
Set the Defaults for Timed Events
Set the Defaults for ToDo Events
Set the Start Time for an Event
Set Up Print Options
Update Media
Use the Media Buttons
Use the Tool Buttons



To Choose Personal Assistants

One of the ways you can remind yourself of upcoming events is to keep track with the help 
of personal assistants.    Your PlanIt comes with assorted media clips (AVI - video, WAV - 
sound , and EYE - eye animation)    that you can use as personal assistants to provide alarm 
reminders on various occasions.    However, you have the option to use other *.AVI or *.WAV 
files as your alarm clips by loading them into your system through the Personal Assistant 
dialog.
1.      From the Options menu, choose Personal Assistant.
2.      From the list of installed media clips, click the desired file to use.

The media clips that you have installed as personal assistants are displayed in the 
Installed Media Clips box.    Click the Up/Down arrows on the scroll bar to view and select 
media clips that are not currently displayed.
To view the media clip selected, click the Preview button.    To edit the title of the media 
clip, type the new title in the Title box.    To delete a media clip, click the Delete button.
If the clip you want to use is not listed in the Installed Media Clips box, you have to add it
to your PlanIt directory.

3.      Specify your personal assistant options for the media clip you selected.
To play the clip each time when you start your PlanIt, click the PlanIt Start check box.    To
play the clip each time when you quit your PlanIt, click the PlanIt Exit check box.    To 
assign the clip as your lunch reminder, click the Lunch check box.    An 'X' in each of 
these boxes indicates the assignment of the selected (highlighted) clip to the 
corresponding events.    To exclude these options, click their respective boxes again.

4.      If you choose the Lunch option, specify the time.
The default time displayed is 12:00 pm.    To change the time, click the Up/Down buttons 
to increase or decrease the time, in increments of 5 minutes.

5.      Click Close to accept the personal assistant.

__________
See also

To Add a Media Clip



To Add a Media Clip

If the clip you want to use is not listed in the Installed Media Clips box of the Personal 
Assistant dialog, you have to add it to your PlanIt directory.
1.      From the list of available media clips, click the desired file to use.

The media clips that come with your PlanIt are displayed in the Available Media Clips box.
Click the Up/Down arrows on the scroll bar to view and select media clips that are not 
currently displayed.
You can type in the video (*.AVI), audio (*.WAV) or eyeball animation (*.EYE) file name, 
including the extension and path in the File box.    You can also use the Browse button to 
find and select media files installed in your system.    For additional information on using 
the Windows Browse dialog, refer to your Microsoft Windows documentation.

2.      Enter the text title of the media file to add.
3.      If you want to view the clip before you add it, click the Preview button.

The clip will be played back in the media box.    Use the media buttons to review the 
selected media clip.

PLAY
Starts playback of desired media clip.

STOP
Stops playback of media clip.

PAUSE
Pauses playback, or resumes playback if paused, of media clip.

FAST FWD
Not used in this dialog.

REWIND
Not used in this dialog.

RECORD
Not used in this dialog.

Note    Full-motion video is available only with the CD-ROM version of the Personal Daily 
PlanIt.

4.      Click OK to install the file as one of your personal assistants.
To quit without adding the media clip, click Cancel.

__________
See also

To Choose Personal Assistants



To Configure Launchers

You have 9 launcher buttons that you can configure to launch different programs and PlanIt 
entertainment features.    The launcher option is accessed from the Preferences in the 
Options menu.

Your program launchers can be configured to run any of the programs that are installed in 
your system, and the entertainment launchers can be configured to activate any available 
entertainment feature.    The features standardly included are::

Isaac Asimov Trivia
Motivational Message
Famous Birthdays
Joke of the Day
Humorous Quotes
Slideshow Viewer
Today's Fortune Cookie
Word of the Day

Your program and entertainment launchers are configured using the Preferences - Launchers
dialog.    You can move from one field to the next in the dialog box by using your mouse to 
point and click the location where you want to position the cursor.    You can also move from 
one field to the next by using the Tab key on your keyboard.    Pressing the Tab key will 
forward you to the field next to the field your cursor is currently on.    Holding the Shift key 
down and pressing the Tab key will move you to the field prior to the field you are currently 
on.    
1.      Click the launcher button to configure.

You have 9 buttons that you can configure to launch various programs and entertainment
features.

2.      Select the launcher to place on the button by clicking the desired launcher 
from the Launchers List.
To select an entertainment launcher, click the desired entertainment.    To select a 
program launcher, click [Program].

3.      If you choose the [Program] launcher, specify the name of the application's 
program file in the Command Line box.
You can type in the application's program file, including the extension and path, or you 
can choose an application program file using the Browse button.
You can use the Browse button to find and select program files installed in your system.    
For additional information on using the Windows Browse dialog, refer to your Microsoft 
Windows documentation.

4.      If you choose the [Program] launcher, enter the text title to display on the 
launcher button.    You can enter up to 10 characters of text title.

5.      If you choose an entertainment launcher, decide whether to include, or 
exclude, the display of Introduction and Text, and the playback of Sound.
The Introduction, Text or Sound of an entertainment launcher, if available, can be 
included by clicking each of their respective check boxes.    An 'X' will appear in the check
box of the item you include.    To exclude these options, click their respective boxes 
again.



6.      Click OK to accept the preferences set for the launchers.
To quit without changing the launcher preferences, click Cancel.

_________
See also

To Launch Programs and Entertainment



To Configure Tool Buttons

The Tool Buttons section can be configured to access the 12 commands that you use most 
frequently, using the Preferences - Tool Buttons dialog.    The tool button option is accessed 
from the Preferences in the Options menu.
1.      Click a tool icon that corresponds to a command that you frequently use.
2.      Drag the icon to the appropriate tool button.

The Tool Icons List displays the commands in your PlanIt that have corresponding tool 
icons.    Click the Up/Down arrows on the scroll bar to view and select tool icons that are 
not currently displayed.
Repeat steps 1 and 2 until you have configured the 12 tool buttons that you can use to 
access the commands that you will use most frequently in your PlanIt.

3.      Click OK to accept the preferences set for the tool buttons.    
To quit without changing the tool buttons, click Cancel.

__________
See also

To Use Tool Buttons



To Customize Tab Preferences

The 6 tabbed planner sections are user-defined, and each section can be set up 
independently.    You can make real estate choices as to the font size to use, the events to 
view in a given section, the event order, and the amount of space to give each event area.    
The tab option is accessed from the Preferences in the Options menu.

You can divide your PlanIt into a maximum of 6 sections, and each section is separated from 
the other sections by its own unique tabbed divider.    Use the Preferences - Tabs dialog to 
configure your planner tabs.
1.      In the Type box, specify the section type for the tab selected.

To select the section type, click the Down arrow to access a list of available sections and 
click the desired section type.    The following section types are available from Your PlanIt:

Day
Day with Picture
2-Day
Week
Week with Picture
2-Week
ToDo
ToDo with Picture
Address Book
Address with Picture

2.      Enter the text to be displayed as the title on the current tab.    You can enter 
up to a maximum of 12 characters.

3.      Select the color for the current tab.
To select the color for the current tab, click the Down arrow to access a palette of 16 
colors, and then click the desired color.

4.      Specify the font size to be used to display the events and address 
information by clicking the Down arrow and selecting the desired font size of 
small, medium or large.
The number of events or address information that can be viewed on the screen depends 
on the font size you choose.    Smaller font size allows you to view more events on the 
display.

5.      Specify your display options for the current tab section.
6.      Specify the area location and size of your event display.

A 2-page planner template is provided for you to select the area location and size of up 
to 3 event types in the current tab section.    You can use the drag and drop interface to 
change the area locations and sizes of the event types selected.
To rearrange the event type areas, drag the event type icon to the new location and drop
it.    For example, if the top half of the right page contains Timed events and the bottom 
half contains the ToDo events, you can drag the ToDo event type icon and drop it in the 
Timed event area.    The locations of these event areas will be interchanged.    Only one 
event type can occupy the left page.
To adjust the size of the event area, or the percentage of the page allocated to each 
event area, drag the dividing line up or down between the event type areas.

7.      Click OK to accept the tab section settings.



To quit without changing the tab settings, click Cancel.

__________
See also

To Navigate with Tabs



To Customize Tab Preferences - Day

1.      In the Type box, click the Down arrow to access a list of available sections 
and click the Day section type.

2.      Enter the text to be displayed as the title on the current tab.    You can enter 
up to a maximum of 12 characters.

3.      Select the color for the current tab.
To select the color for the current tab, click the Down arrow to access a palette of 16 
colors, and then click the desired color.

4.      Specify the font size to be used to display the events by clicking the Down 
arrow and selecting the desired font size of small, medium or large.
The number of events that can be viewed on the screen depends on the font size you 
choose.    Smaller font size allows you to view more events on the display.

5.      Specify your display options for the current tab section.
3 check boxes are provided to allow you to determine the event types you want to 
display for the current tab section.    To display an event type in the current section, click 
the check box of the event type and an 'X' will appear in the box.    Click the check box 
again and the 'X' will disappear indicating that the particular event type will not be 
displayed in the current section.    The order that the boxes are checked determines the 
initial ordering of event types on the pages of the current tab section.
If you want to display ToDo events for the current section, specify further if you want to 
display completed and/or canceled ToDo events.

6.      Specify the number of lines to display for each of the types of events.
The minimum number of lines per event is 2, and the maximum number of lines is 5.    To 
specify the number of lines to display for each event, click the Up/Down buttons to 
increase or decrease the number of lines.

7.      Specify the area location and size of your event display.
A 2-page planner template is provided for you to select the area location and size of up 
to 3 event types in the current tab section.    You can use the drag and drop interface to 
change the area locations and sizes of the event types selected.
To rearrange the event type areas, drag the event type icon to the new location and drop
it.    For example, if the top half of the right page contains Timed events and the bottom 
half contains the ToDo events, you can drag the ToDo event type icon and drop it in the 
Timed event area.    The locations of these event areas will be interchanged.    Only one 
event type can occupy the left page.
To adjust the size of the event area, or the percentage of the page allocated to each 
event area, drag the dividing line up or down between the event type areas.
The first event type you check for display will appear full page on the left page of the 
template.    The next event type you check will appear full page on the right page of the 
template.    The third event type will appear on the bottom half of the right page, and the 
second event type will correspondingly be reduced to occupy the top 50% of the right 
page.    If only one event type is selected, that event type occupies both pages.    
However, no event can span more than one page.

8.      Click OK to accept the tab section settings.



To quit without changing the tab settings, click Cancel.

__________
See also

To Customize Tab Preferences



To Customize Tab Preferences - Day with Picture

1.      In the Type box, click the Down arrow to access a list of available sections 
and click the Day with Picture section type.

2.      Enter the text to be displayed as the title on the current tab.    You can enter 
up to a maximum of 12 characters.

3.      Select the color for the current tab.
To select the color for the current tab, click the Down arrow to access a palette of 16 
colors, and then click the desired color.

4.      Specify the font size to be used to display the events by clicking the Down 
arrow and selecting the desired font size of small, medium or large.
The number of events that can be viewed on the screen depends on the font size you 
choose.    Smaller font size allows you to view more events on the display.

5.      Specify your display options for the current tab section.
3 check boxes are provided to allow you to determine the event types you want to 
display for the current tab section.    To display an event type in the current section, click 
the check box of the event type and an 'X' will appear in the box.    Click the check box 
again and the 'X' will disappear indicating that the particular event type will not be 
displayed in the current section.    The order that the boxes are checked determines the 
initial ordering of event types on the pages of the current tab section.
If you want to display ToDo events for the current section, specify further if you want to 
display completed and/or canceled ToDo events.

6.      Specify the number of lines to display for each of the types of events.
The minimum number of lines per event is 2, and the maximum number of lines is 5.    To 
specify the number of lines to display for each event, click the Up/Down buttons to 
increase or decrease the number of lines.

7.      Specify the area location and size of your event display.
A 2-page planner template is provided for you to select the area location and size of up 
to 3 event types in the current tab section.    You can use the drag and drop interface to 
change the area locations and sizes of the event types selected.
To rearrange the event type areas, drag the event type icon to the new location and drop
it.    For example, if the top half of the right page contains Timed events and the bottom 
half contains the ToDo events, you can drag the ToDo event type icon and drop it in the 
Timed event area.    The locations of these event areas will be interchanged.
To adjust the size of the event area, or the percentage of the page allocated to each 
event area, drag the dividing line up or down between the event type areas.
The picture will be displayed on the left page of the template.    The first event type you 
check for display will appear full page on the right page of the template.    The next event
type will appear on the bottom 50% of the right page. The third event type you check will
appear on the bottom third of the right page, and the first and second event types will 
correspondingly be reduced to occupy the top and middle third of the right page, 
respectively.

8.      Click OK to accept the tab section settings.
To quit without changing the tab settings, click Cancel.



__________
See also

To Customize Tab Preferences



To Customize Tab Preferences - 2 Day

1.      In the Type box, click the Down arrow to access a list of available sections 
and click the 2 Day section type.

2.      Enter the text to be displayed as the title on the current tab.    You can enter 
up to a maximum of 12 characters.

3.      Select the color for the current tab.
To select the color for the current tab, click the Down arrow to access a palette of 16 
colors, and then click the desired color.

4.      Specify the font size to be used to display the events by clicking the Down 
arrow and selecting the desired font size of small, medium or large.
The number of events that can be viewed on the screen depends on the font size you 
choose.    Smaller font size allows you to view more events on the display.

5.      Specify your display options for the current tab section.
3 check boxes are provided to allow you to determine the event types you want to 
display for the current tab section.    To display an event type in the current section, click 
the check box of the event type and an 'X' will appear in the box.    Click the check box 
again and the 'X' will disappear indicating that the particular event type will not be 
displayed in the current section.    The order that the boxes are checked determines the 
initial ordering of event types on the pages of the current tab section.
If you want to display ToDo events for the current section, specify further if you want to 
display completed and/or canceled ToDo events.

6.      Specify the number of lines to display for each of the types of events.
The minimum number of lines per event is 2, and the maximum number of lines is 5.    To 
specify the number of lines to display for each event, click the Up/Down buttons to 
increase or decrease the number of lines.

7.      Specify the area location and size of your event display.
A 2-page planner template is provided for you to select the area location and size of up 
to 3 event types in the current tab section.    You can use the drag and drop interface to 
change the area locations and sizes of the event types selected.
To rearrange the event type areas, drag the event type icon to the new location and drop
it.    For example, if the top half of the right page contains Timed events and the bottom 
half contains the ToDo events, you can drag the ToDo event type icon and drop it in the 
Timed event area.    The locations of these event areas will be interchanged.
To adjust the size of the event area, or the percentage of the page allocated to each 
event area, drag the dividing line up or down between the event type areas.
The first event type you check for display will appear full page on one page of the 
template.    The next event type will appear on the bottom 50% of the same page. The 
third event type you check will appear on the bottom third of the page, and the first and 
second event types will correspondingly be reduced to occupy the top and middle third 
of the same page, respectively.    The other page will be in exactly the same format.    

8.      Click OK to accept the tab section settings.
To quit without changing the tab settings, click Cancel.



__________
See also

To Customize Tab Preferences



To Customize Tab Preferences - Week

1.      In the Type box, click the Down arrow to access a list of available sections 
and click the Week section type.

2.      Enter the text to be displayed as the title on the current tab.    You can enter 
up to a maximum of 12 characters.

3.      Select the color for the current tab.
To select the color for the current tab, click the Down arrow to access a palette of 16 
colors, and then click the desired color.

4.      Specify the font size to be used to display the events by clicking the Down 
arrow and selecting the desired font size of small, medium or large.
The number of events that can be viewed on the screen depends on the font size you 
choose.    Smaller font size allows you to view more events on the display.

5.      Specify your display options for the current tab section.
3 check boxes are provided to allow you to determine the event types you want to 
display for the current tab section.    To display an event type in the current section, click 
the check box of the event type and an 'X' will appear in the box.    Click the check box 
again and the 'X' will disappear indicating that the particular event type will not be 
displayed in the current section.    The order that the boxes are checked determines the 
initial ordering of event types on the pages of the current tab section.
If you want to display ToDo events for the current section, specify further if you want to 
display completed and/or canceled ToDo events.

6.      Specify the number of lines to display for each of the types of events.
The minimum number of lines per event is 1, and the maximum number of lines is 4.    To 
specify the number of lines to display for each event, click the Up/Down buttons to 
increase or decrease the number of lines.

7.      Specify if you want to display weekends for the current section.
To display Saturdays and Sundays in the planner, click the Weekends check box and an 
'X' will appear in the box.    To exclude weekends from the display, click the box again.

8.      Click OK to accept the tab section settings.
To quit without changing the tab settings, click Cancel.

__________
See also

To Customize Tab Preferences



To Customize Tab Preferences - Week with Picture

1.      In the Type box, click the Down arrow to access a list of available sections 
and click the Week with Picture section type.

2.      Enter the text to be displayed as the title on the current tab.    You can enter 
up to a maximum of 12 characters.

3.      Select the color for the current tab.
To select the color for the current tab, click the Down arrow to access a palette of 16 
colors, and then click the desired color.

4.      Specify the font size to be used to display the events by clicking the Down 
arrow and selecting the desired font size of small, medium or large.
The number of events that can be viewed on the screen depends on the font size you 
choose.    Smaller font size allows you to view more events on the display.

5.      Specify your display options for the current tab section.
3 check boxes are provided to allow you to determine the event types you want to 
display for the current tab section.    To display an event type in the current section, click 
the check box of the event type and an 'X' will appear in the box.    Click the check box 
again and the 'X' will disappear indicating that the particular event type will not be 
displayed in the current section.    The order that the boxes are checked determines the 
initial ordering of event types on the pages of the current tab section.
If you want to display ToDo events for the current section, specify further if you want to 
display completed and/or canceled ToDo events.

6.      Specify the number of lines to display for each of the types of events.
The minimum number of lines per event is 1, and the maximum number of lines is 4.    To 
specify the number of lines to display for each event, click the Up/Down buttons to 
increase or decrease the number of lines.

7.      Specify if you want to display weekends for the current section.
To display Saturdays and Sundays in the planner, click the Weekends check box and an 
'X' will appear in the box.    To exclude weekends from the display, click the box again.

8.      Click OK to accept the tab section settings.
To quit without changing the tab settings, click Cancel.

__________
See also

To Customize Tab Preferences



To Customize Tab Preferences - 2 Week

1.      In the Type box, click the Down arrow to access a list of available sections 
and click the 2 Week section type.

2.      Enter the text to be displayed as the title on the current tab.    You can enter 
up to a maximum of 12 characters.

3.      Select the color for the current tab.
To select the color for the current tab, click the Down arrow to access a palette of 16 
colors, and then click the desired color.

4.      Specify the font size to be used to display the events by clicking the Down 
arrow and selecting the desired font size of small, medium or large.
The number of events that can be viewed on the screen depends on the font size you 
choose.    Smaller font size allows you to view more events on the display.

5.      Specify your display options for the current tab section.
3 check boxes are provided to allow you to determine the event types you want to 
display for the current tab section.    To display an event type in the current section, click 
the check box of the event type and an 'X' will appear in the box.    Click the check box 
again and the 'X' will disappear indicating that the particular event type will not be 
displayed in the current section.    The order that the boxes are checked determines the 
initial ordering of event types on the pages of the current tab section.
If you want to display ToDo events for the current section, specify further if you want to 
display completed and/or canceled ToDo events.

6.      Specify the number of lines to display for each of the types of events.
The minimum number of lines per event is 1, and the maximum number of lines is 4.    To 
specify the number of lines to display for each event, click the Up/Down buttons to 
increase or decrease the number of lines.

7.      Specify if you want to display weekends for the current section.
To display Saturdays and Sundays in the planner, click the Weekends check box and an 
'X' will appear in the box.    To exclude weekends from the display, click the box again.

8.      Click OK to accept the tab section settings.
To quit without changing the tab settings, click Cancel.

__________
See also

To Customize Tab Preferences



To Customize Tab Preferences - Address Book, Address with Picture

1.      In the Type box, click the Down arrow to access a list of available sections 
and click the Address Book or Address with Picture section type.

2.      Enter the text to be displayed as the title on the current tab.    You can enter 
up to a maximum of 12 characters.

3.      Select the color for the current tab.
To select the color for the current tab, click the Down arrow to access a palette of 16 
colors, and then click the desired color.

4.      Specify the font size to be used to display the address information by clicking
the Down arrow and selecting the desired font size of small, medium or large.
The number of address information that can be viewed on the screen depends on the 
font size you choose.    Smaller font size allows you to view more events on the display.

5.      Specify your display options for the current tab section.
Select the address information to display by clicking the button next to the desired 
address information.

6.      Indicate how you want your Address Book to be sorted.
You have the option to sort your Address Book by Name or by Company Name.

7.      Click OK to accept the tab section settings.
To quit without changing the tab settings, click Cancel.

__________
See also

To Customize Tab Preferences



To Customize Tab Preferences - ToDo, ToDo with Picture

1.      In the Type box, click the Down arrow to access a list of available sections 
and click the ToDo or ToDo with Picture section type.

2.      Enter the text to be displayed as the title on the current tab.    You can enter 
up to a maximum of 12 characters.

3.      Select the color for the current tab.
To select the color for the current tab, click the Down arrow to access a palette of 16 
colors, and then click the desired color.

4.      Specify the font size to be used to display the ToDo events by clicking the 
Down arrow and selecting the desired font size of small, medium or large.
The number of ToDo events that can be viewed on the screen depends on the font size 
you choose.    Smaller font size allows you to view more events on the display.

5.      Specify your display options for the current tab section.

If you want to display completed and/or canceled ToDo events, click the corresponding 
check boxes.

6.      Specify the number of lines to display for the ToDo events.
The minimum number of lines per event is 1, and the maximum number of lines is 4.    To 
specify the number of lines to display for each ToDo event, click the Up/Down buttons to 
increase or decrease the number of lines.

7.      Click OK to accept the tab section settings.
To quit without changing the tab settings, click Cancel.

__________
See also

To Customize Tab Preferences



To Import Photo

You can create your own PlanIt by importing images from your favorite photo CDs.    Instead 
of any of the images that comes with your PlanIt, you can bring in a photo from another 
photo CD.
1.      From the File menu, choose Import Photo.
2.      Specify the CD-ROM drive in which you have your photo CD.

To access a list of the CD-ROM drives in your system, click the Down arrow in the CD-
ROM Drives box.    Select your CD-ROM drive by clicking the desired drive from the list.
All the photo CD files will be loaded and listed in the PCD Files box.    Click the Up/Down 
arrows of the scroll bar to access files that are not currently displayed in the PCD Files 
box.

3.      Choose the image that you want to import into your PlanIt by clicking the 
desired filename in the PCD Files box.
You can view an image before you actually import the photo by clicking the Preview 
toggle button.    An 'X' in the Preview toggle button will bring up the image you selected 
onto the Preview box.

4.      Specify the purpose for which you are importing the photo.
In the Use As box, specify how you want to use the photo you import.    The following 
options are available:

Generic Day (for the same day each month)
Specific Day (for a specific month and day)
Month
Year

You can enter any one of these options by entering the first letter of the option, or by 
clicking the Down arrow and clicking the desired option.

5.      Determine the specific day or date, week, or month that you want to import 
the photo to.
If you choose to use the photo you import as the image for a Generic Day, specify the 
day by clicking the corresponding day icon of the particular day you want.    The day 
icons are numbered from 1 to 31, and are displayed below the Use As box.
If you choose to use the photo for a Specific Day, specify the month by clicking the 
Left/Right arrows beside the month text until you come upon the month you want.    On 
the day icons, click the corresponding day icon of the specific day that you want to use 
the photo you import.
If you choose to use the photo you import for a Month, select the specific month by 
clicking the corresponding month icon that is displayed below the Use As box.

6.      Click Import to load the photo.
To quit the Import Photo dialog, click Close.    To delete a photo CD file, click Delete.



To Launch Programs and Entertainment

Click any one of the 9 launchers and you can access the various entertainment features that
come with your PlanIt, as well as any of the programs that are installed in your system.    
Each of the launcher buttons can be configured using the Preferences in the Options menu.

A program launcher will run the application that you configure on your launcher button.    You
can return to your PlanIt in the same manner that you switch between applications.    For 
additional information on switching between applications, refer to your Microsoft Windows 
documentation.

An entertainment launcher will feature the daily entertainment for the category you select.    
The animated introduction is displayed in the media box and you can use the media buttons 
to control the media clip.

PLAY
Starts playback of desired media clip.

STOP
Stops playback of media clip.

PAUSE
Pauses playback, or resumes playback if paused, of media clip.

FAST FWD
Not used in the launchers.

REWIND
Not used in the launchers.

RECORD
Not used in the launchers.
Note    Some sounds and full-motion video are available only with the CD-ROM version of 
the Personal Daily PlanIt.    Sound and video clips require Video for Windows (VFW) v1.1 
runtime file sto be installed.    If you did not install VFW upon PlanIt installation, you may 
install VFW by double-clicking the Video for Windows 1.1 Runtime Setup icon in the 
Personal Daily PlanIt group.

The text, on the other hand, is displayed on the lower half of your PlanIt.    You can access 
the next entry in the list of the selected entertainment by clicking the Next button in the 
media box, or the previous entry by clicking the Prev button.    To quit the entertainment 
feature, click Close.

__________
See also

To Configure Launchers
To Launch Slide Show



To Launch Slide Show

If you have configured your launcher buttons to include Slideshow Viewer, you can enjoy a 
slide show presentation of all the images contained in your PlanIt simply by clicking your 
Slide Show launcher button.    You can also put together a slide show presentation of all the 
images contained on the PlanIt CD-ROM.

The Slideshow Viewer is implemented using the Slide Show dialog, and is accessed by 
clicking the Slide Show launcher button.
1.      Specify the drive from which you will launch your slide show.

Whether you are launching your slide show from the CD-ROM or the hard drive, click the 
button next to the drive that you will view the images from.

2.      Choose the images that you want to view by checking in the boxes 
corresponding to the images you want to view.
To include the images in your slide show, click the check boxes next to the different 
categories of images.    An 'X' in each of the check boxes indicates that the images in that
particular category will be displayed on the screen for viewing.    To de-select, or exclude, 
a category of images, click the particular check box again and the 'X' will disappear from 
the check box.

3.      Specify the slide show mode of operation.
To put the Slideshow Viewer on automatic playback, click the Auto Play check box and an
'X' will appear in the check box.    The amount of time an image will remain on the screen
will be determined by the amount of time specified in the Delay box.    To manually 
project the images, click the Auto Play check box again and the 'X' will disappear from 
the Auto Play check box.    
Note    It is recommended to display the controls if you opt for manual slide projection.

4.      If the Auto Play option is selected, specify in the Delay box the amount of 
time an image will remain on the screen.
To specify the amount of delay time for your slide show, click the Up/Down arrows to 
change the time displayed in the Delay box, 1 second at a time.

5.      Specify whether to display or hide the controls during the slide show 
presentation.    
To display the controls, click the Display Controls check box.    An 'X' will appear in the 
check box indicating that the controls will be displayed on the bottom right corner of the 
screen during image projection.    To hide the display controls, click the Display Controls 
check box again and the 'X' will disappear.
The display controls are composed of the following:

Previous button
Auto/Stop toggle
Next button

To view the image previous to the image currently displayed on the screen, click the 
Previous button.    To view the image next to the image currently displayed, click the Next
button.    To change the mode of operation of the slide show, click the Auto/Stop toggle 
switch.    Clicking the Auto/Stop toggle switch toggles between automatic playback and 
manual operation mode.



6.      Click OK to launch the slide show.    
To quit without launching the slide show, click Cancel.

__________
See also

To Configure Launchers
To Launch Programs and Entertainment



To Maintain Locations

When you schedule Timed events, the locations that you select from are updated and 
maintained using the Locations dialog.    The Locations dialog can be accessed from 
Locations of the Options menu.    It can also be accessed by clicking the button to the left of 
the Event Location box in the Timed Event dialog.

To add a location
1.      In the Location box, type in the name or description of the location you want 

to add.    You can enter up to a maximum of 30 characters.
2.      Click the Add button.

The Locations List will be updated to include the location you just added.
3.      Click Close to quit the Locations dialog.

To delete a location
1.      Click to highlight the location in the Locations List.

The Locations List displays the locations that you currently have in your file.    Click the 
Up/Down arrows of the scroll bar to view locations that are not displayed.

2.      Click the Delete button.
The location you just deleted will be removed from the Locations List.

3.      Click Close to quit the Locations dialog.

__________
See also

To Schedule Timed Events



To Manage Address Book Entries

Entries in your Address Book can be sorted by last name or by company, and you can select 
your sorting preference by clicking the appropriate sort-by bar on the left page of your 
Address Book.    Clicking on sort by Name sorts the entries first by last name, then by first 
name, then by company;    clicking on sort by Company sorts the entries first by company, 
then by first name, then by last name;    

Each of the entries in your Address Book will be categorized under the letter tab that 
corresponds to the first letter of the entry's name or company depending on your sorting 
preference.    The thirteen letter tabs on the right page each contain two letters of the 
alphabet.    If there are no entries for a given tab, it will be grayed out and you will not be 
able to select it.    The currently selected    letter tab will appear depressed.    To select a 
different letter tab, click on the desired tab.    To go to the second letter on the tab, 
doubleclick the depressed tab.

Address Book entries are created by choosing Address Entry from the Insert menu, or by 
clicking the  Tool Button.    You can also create a new address entry by double-clicking any 
white space outside an entry in the Address Book.    An Address Book entry that had been 
previously entered can be edited by displaying the entry using the address tabs, and double-
clicking the entry that is displayed.

Address Book entries are created and edited using the Address Book dialog.    You can move 
from one field to the next by using the Tab key on your keyboard.    Pressing the Tab key will 
forward you to the field next to the field your cursor is currently on.    Holding the Shift key 
down and pressing the Tab key will move you to the field prior to the field you are currently 
on.    You can also use your mouse to point and click the location where you want to position 
the cursor.
1.      Specify the title of the person.

To select a person's title, click the Down arrow to access a list of available titles and then 
click the desired title from the list.    The available titles are:

Mr.
Mrs.
Ms.
Dr.

You may type in any title.    You can also leave the title blank if no title is necessary. 
2.      Type in the person's first name.
3.      Type in the person's last name.
4.      Enter the person's position.
5.      Enter the company represented by the person.

The PlanIt will automatically search for a similar company.    If simlar companies are 
found, the PlanIt will offer to fill in the remaining address information for you - this 
includes company, phone, fax, and address.

6.      Enter the person's telephone number. 
7.      Enter the facsimile number, if any.
8.      Enter the address information of the person.

You can enter address information, such as street, city, state, and zip code in this box.    
Use the scroll bar to view text that is not displayed.



9.      Enter information to the user-defined fields.
The titles of each of the user-defined fields are set in the Defaults of the Options menu.

10. Enter personal notes about this entry.    
Use the scroll bar to view text that is not displayed.

11. Click OK to accept entry.
Click Blank to blank all data entry fields for this entry, or click Delete to delete the 
current entry displayed.    To quit without saving entry, click Cancel.

__________
See also

To Set the Defaults for Address Book



To Navigate Your PlanIt

Understanding the logic behind the PlanIt shortcuts will help you to move around your PlanIt 
more effectively.    Efficient navigation of your PlanIt, of course, will lead to efficient 
management of your information.

You can move from one page to the next in your planner by clicking the upper corners of 
your planner page.    Clicking the upper left corner will take you to the page prior to the page
that you are currently on.    Clicking the right corner will take you to the page following the 
page that you are currently on.    You can also go around your PlanIt with Tabs, as well as with
the Goto Commands.



To Navigate with Tabs

 From the ViewViewMenu menu, choose PlannerViewPlan and then click the 
tabbed section to access, 

- or -
 Click the tabbed divider of the section you want to access.

Your PlanIt comes with 6 sections that you can customize to manage your information in the 
most effective manner.    Each section is separated from the other sections by its own unique
tabbed divider, and you can set up each section independently.    You can make real estate 
choices as to the font size to use, the events to view in a given section, the event order, and 
the amount of space to give each event area.

You can define each of the 6 sections from the following available section types:
Day
Day with Picture
2-Day
Week
Week with Picture
2-Week
ToDo
ToDo with Picture
Address Book
Address with Picture

__________
See also

To Customize Tab Preferences
To Navigate Your PlanIt



To Navigate with Goto Commands

You can move quickly to a specific date by using the Goto commands.    The Goto commands 
allow you to go to different dates without having to turn the pages.

If you want to go directly to the date today, use Goto Today.
 From the View menu, choose Goto Today (Ctrl+T),
- or -
 Click the 
 Tool Button.

The date today is the system date of your PlanIt.    To change the date today, choose Edit 
Date/Time from the Edit menu.

If, on the other hand, you want to go to a specific date, use Goto Date.
1.      From the View menu, choose Goto Date (Ctrl+G),

- or -
Click the  Tool Button.
The Standard Calendar dialog with the current planner date attached to its left will be 
accessed.

2.      Determine the month of the date you want to go to.
The monthly calendar displayed is the current month and year.    The date today or the 
system date of your PlanIt is highlighted in blue, and the current date for which you are 
scheduling an event is highlighted in green.    To select a month different from the current
planner month, click the Left/Right buttons to the left of the month text to change the 
month, 1 month at a time.    Changes in the currently displayed planner month 
correspondingly change the display of the 3-Month Preview section.
You can also use the 3-Month Preview section to change the month displayed.    Scroll 
through the 3-month calendar and click the chosen month of the desired year.    The 
month selected will be displayed as the monthly calendar.

3.      Choose the year of the desired date.
The default year displayed is the current planner year.    To select a year different from 
the display, click the Left/Right buttons to the left of the year display to change the year, 
in increments of 1 year.    Changes in the currently displayed planner year will be 
reflected in the 3-Month Preview section.    

4.      In the monthly calendar, click the date to go to.
The date selected will be displayed in the box to the left of the Standard Calendar dialog.

5.      Click OK to go to the date specified.
To go to the date today, click Today.    To quit without proceeding to the date indicated, 
click Cancel.

__________
See also

To Navigate Your PlanIt
To Set the Date for an Event





To Print from Your PlanIt

Information from your PlanIt is printed using the Print dialog.    You can specify the data and 
data range, and the page layout of the output.
1.      From the File menu, choose Print (Ctrl+P),

- or -
Click the  Tool Button.

2.      In the Layout box, specify the page layout of the output.
Click the Down arrow to access a list of available page layouts, and select the desired 
layout.    The page layouts are defined using the Page Setup command from the File 
menu.

3.      Specify the section to print.
Click the Down arrow to access a list of output sections, and click the desired section.    
The available sections are:

Planner
ToDo List
Address Book
Location List

4.      In the Printer box, indicate the printer you will use.
Click the Down arrow to access a list of installed printers, and select the printer to use.    
You can install additional printers, and change the printer settings from the Control Panel 
of your Program Manager.    For additional information, refer to your Microsoft Windows 
documentation.

5.      Specify the number of copies you want to print.
Click the Up/Down arrow to change the number of copies to print.

6.      Indicate whether to print all the information for the section selected, or just 
a certain range.    
For the Planner and ToDo List sections, Next 7 Days prints information of all upcoming 
events for the next 7 days.    Next 30 Days prints information of all events for the next 30 
days.    And From/To specifies the date range of the events to print.
For the Address Book and Location List sections, All Entries will print all the entries in the 
Address Book or Location file.    From/To specifies the alphabetical range of the entries to 
print.

7.      If you choose to print information for a certain range, specify the date range 
for the Planner and ToDo List sections, or the alphabetical range for the 
Address Book and Location List sections.
The default date displayed in the From and To boxes is the current planner date.    To 
change the range of dates to print, click the Up/Down buttons to select the dates in the 
From and To boxes.    You can also change the From and To dates by clicking the Goto 
Date icon, , to the right of the From and To boxes.    
Note    The date set in the To box cannot be earlier than the date set in the From box.
The default records in the From and To boxes are the first and the last records in your 
Address Book for your Address Book section, or the first and the last records in your 
Location file for the Location List section.    To change the range of names to print, click 



the Up/Down buttons to select the names in the From and To boxes.
Note    The name set in the To box cannot be alphabetically earlier than the name set in 
the From box.

8.      You have the option to edit and change your page setup and print options 
before you proceed to print.
Use the Page button to change the page settings of the output.    The Page Setup dialog 
will be accessed.
Use the Options button to select which information to include in each of the print 
sections specified.    The Print Options dialog will be accessed.

9.      Click OK to print.
To see on the screen how your output will look before you actually print it, click Preview. 
To quit without printing, click Cancel.    

__________
See also

To Maintain Locations
To Manage Address Book Entries
To Navigate with Goto Commands
To Set Up Page Settings to Print
To Set Up Print Options



To Record Voice Annotation to an Event

You have the option of recording a voice annotation of up to 2 minutes to each of the events 
you schedule by clicking the Voice button from any event dialog.    You can also click the 
Voice Annotation Off icon, , or the Voice Annotation On icon, 

, that is displayed to the right of the event in the Day View planner.

A voice annotation is recorded to an event using the Voice Annotation dialog.    Voice 
annotation activities utilize the media box and media control buttons located on the upper 
left screen of your PlanIt.    The media box provides instructions on the recording of your 
voice annotation by displaying a series of screens as you progress through the recording.    
The media buttons are the button switches you use to control the recording.
1.      Begin recording the voice annotation.

The first screen of the Voice Annotation dialog prompts you to start or cancel the 
recording.    To start the recording, click the Record button, , and begin speaking into 
the microphone.    To cancel the recording sequence, click Cancel.
As you are recording, the current status of your voice annotation will be displayed.
If the recording of audio is in process, this media sequence reminds you that audio 
recording is in process.    Both the lengths of the recording in seconds and the storage 
space being consumed in MB will be displayed.    To pause the recording, click the Pause 
button.    To stop the recording, click the Stop button.    The record sequence 
automatically stops after 2 full minutes (120 seconds) of audio recording.
If the recording sequence has been paused, click the Pause button again to resume the 
recording, and continue speaking into the microphone.    To stop the recording, click the 
Stop button.    

2.      Stop the recording of your voice annotation.    
Recording will automatically stop after 2 minutes of recording, and you will be informed 
of such action on the screen.    To stop recording before the 2 minutes is up, click the Stop
button.

3.      You can review and edit the voice annotation if you want to.
Use the media buttons to record, play, review and edit your voice annotation sequence.

RECORD
Activates the voice annotation recording.

PLAY
Starts playback of the annotation sequence.

STOP
Stops playback, fast forwarding, rewinding, or recording of annotation sequence.    

PAUSE
Pauses playback and recording, or resumes playback and recording if paused, of 
annotation sequence.    To temporarily stop the playback or recording of the sequence, 
click the Pause button.    To resume playback or recording, click the Pause button again.

FAST FWD
Quickly forwards to the end of the annotation sequence.

REWIND
Rewinds to the beginning of the annotation sequence. 
Note    Full-motion video is available only with the CD-ROM version of the Personal 
Daily PlanIt.



4.      Save or cancel the voice annotation.    
To save the voice annotation, click OK on the media box screen.    To delete the 
annotation sequence that has been recorded, click Delete.    To quit the voice annotation 
sequence without saving the recording, click Cancel.

__________
See also

To Schedule Day Events
To Schedule Timed Events
To Schedule ToDo Events



To Schedule Day Events 

An event that occurs sometime during the course of a day is a Day event.    Time is not of 
the essence for Day events.    Examples will include anniversaries, birthdays, and holidays.

Day events are created and edited using the Day Event dialog.    The Day Event dialog can 
be accessed from the Day Event of the Insert menu.    Clicking the  Tool Button, or double-
clicking any white space below the events that you have scheduled in the Day event area of 
a planner page also accesses the Day Event dialog.    It can also be accessed by clicking the 
dateline of the event planner page and then clicking the 

, or the New Day Event icon.    To edit a Day event that had been previously scheduled, 
double-click the Day event that is displayed on the planner page.
1.      Determine the date when you want to schedule your Day event.

The Standard Calendar, located on the right of the Day Event dialog, is used to schedule 
Day events.
The monthly calendar displays the month and year of the date for which you are 
scheduling an event.    The date today    or the system date of your PlanIt is highlighted in
blue, and the current planner date for which you are scheduling an event is highlighted 
in green.    On the right of the monthly calendar, the 3 months subsequent to the monthly
calendar are also displayed.    Click the Up/Down arrows on the scroll bar to view months 
that are not currently displayed.
You can change the monthly calendar display by clicking the Left/Right arrows of the 
Month or Year text above the calendar, or you can scroll through the 3-month calendar 
and click the month of the desired year.

2.      Click an event icon and drag that icon onto the desired day on the monthly 
calendar.
The Event Icon Bar displays 2 rows and 7 columns of event icons.    The default event 
icons displayed are set in the Defaults of the Options menu
Each one of the event icons has a corresponding event name, and each icon represents a
Day event that can be scheduled on a given day.

3.      Set the duration of the event, in number of days, by clicking the Up/Down 
buttons.    Each click represents a duration of 1 day.
The default event duration is set in the Defaults of the Options menu

4.      Enter the event name.
The event name is automatically displayed in the Event Name box when you click a Day 
event icon and drag it onto a desired day in the monthly calendar.    Default event names 
are set up in the Defaults of the Options menu.    You can, however, edit this text by 
typing over the text displayed.

5.      Enter any event description notes associated with the event.
You can enter any comments or other details in the Event Notes box by typing the text in
the box.    Click the Up/Down arrows of the scroll bar to view text that are not displayed.

6.      You have the option to record a voice annotation, set an alarm, or schedule 
the event as a recurring event.
Use the Voice button to record a voice annotation to the event.    The Voice Annotation 
dialog will be accessed.



Use the Alarm button to set an alarm to provide a reminder of this event.    The Alarm 
dialog will be accessed.
Use the Recur button to schedule this event as a recurring event.    The Recur Event 
dialog will be accessed.

7.      Click OK to accept the schedule for the Day event.    
To quit without saving the schedule, click Cancel.

__________
See also

To Set the Date for an Event
To Set the Defaults for Day Events



To Schedule Recurring Events

A recurring event is an event that conforms to a definable schedule and recurs over a period
of time.    Events are scheduled as recurring events by clicking the Recur button from the 
Timed Event dialog and the Day Event dialog.    The date that is set for the event and 
displayed in the Starting From box, will be the date from which the event is to start 
recurring.    Recurring events are created and edited using the Recur Event dialog.
1.      In the Recur Frequency box, specify how often the event will recur.

To change the frequency, click the Down arrow to access a list of recurring frequency and
click the desired frequency.    You have the option of setting this event to recur Daily, 
Weekly, Monthly, or Annually.
If the recur frequency is on a weekly basis, you have to specify how often the event is to 
recur each week.    If the recur frequency is on a monthly basis, you have to specify how 
often the event is to recur each month.
An event can recur until a given ending date, continue for a specified duration, or 
continue forever at the specified recur frequency.

2.      If the event is to recur until a specific date, set the ending date of the 
recurring event in the Ending On box.
The default date displayed is the current planner date.    To change the date, in 1-day 
increments, click the Up/Down buttons.    You can also change this date through the 
Standard Calendar dialog by clicking the  to the right of the Up/Down buttons.

3.      If the event is to recur for a certain number of times, click the Continue 
button to activate the Continuing For boxes and specify the length of time this 
recurring event is to continue.
The default duration displayed in the Continuing For boxes is 1 Day.    To change the 
number, 1 at a time, click the up/down buttons in the Amount box.    To change the 
duration unit, click the Down arrow to access a list, and click one of the available units of 
Day(s), Week(s), Month(s) or Year(s) from the list.

4.      If the event is to recur at the specified recur frequency intervals for an 
indefinite period of time, click to activate the No End toggle switch.

5.      Click OK to accept the schedule for the recurring event.
To remove the recurring event schedule, click Delete.    To quit without saving the 
schedule, click Cancel.

__________
See also

To Schedule Day Events
To Schedule Monthly Recurring Event
To Schedule Timed Events
To Schedule ToDo Events
To Schedule Weekly Recurring Event
To Set the Date for an Event



To Schedule Weekly Recurring Events

A recurring event can be set up to conform to a weekly schedule.

If you have determined a weekly recur frequency on the Recur Event dialog, the Weekly 
Recur Event dialog will be displayed to the right of the Recur Event dialog.

The Weekly Recur Event dialog simply allows you to indicate how often an event is to recur 
each week.    The frequency counter, which is for display purposes only, summarizes this 
information.

A row of toggle switches labeled Sun, Mon, Tue, Wed, Thu, Fri, and Sat is displayed to allow 
you to select which day or days of the week the event will recur.    The toggle switches are 
activated and deactivated simply by clicking the button switches on and off.    As such, the 
first click selects the day, and the second click de-selects the day.

To select the day or days of the week this event is to recur, click each of the buttons of the 
days to select.    To de-select a previously selected day, click the particular day again.    Each 
selected day increments the frequency counter by 1.

__________
See also

To Schedule Recurring Events
To Set the Date for an Event



To Schedule Monthly Recurring Events

A recurring event can be set up to conform to a monthly schedule.

If you have determined a monthly recur frequency on the Recur Event dialog, the Monthly 
Recur Event dialog will be displayed to the right of the Recur Event dialog.

The Monthly Recur Event dialog simply allows you to indicate how often an event is to recur 
each month.    The frequency counter at the top of the dialog, which is for display purposes 
only, summarizes this information.
1.      Click the Day /Date toggle switch to specify whether the monthly recurring 

event is to recur on selected days of the week in the month, or on selected 
dates.
If the Day switch is activated, rows of toggle switches labeled Sun, Mon, Tue, Wed, Thu, 
Fri, and Sat, and columns of toggle switches labeled First, Second, Third, Fourth, and Last
will be displayed to allow selection of monthly recurring frequency by days of the month.
If the Date switch is activated, rows and columns of toggle switches labeled 1 to 31 will 
be displayed for you to select monthly recurring frequency by specific dates.

2.      If the monthly recurring event is to recur on selected day or days of the 
month, select the day or days the event is to recur.
Click the day or days of the particular week of the month the event is to recur.    For 
example, if an event is to recur on every first Monday and fourth Thursday of every 
month, then you will click the day buttons that correspond to the column First, row Mon 
and column Fourth, row Thu.
The day buttons are toggle switches, so the first click selects the day, and the second 
click de-selects the day.    Each selected day increments the frequency counter by 1.

3.      If the monthly recurring event is to recur on selected dates of each month, 
select the date or dates.
Click each of the buttons of the dates to select.    The date buttons are toggle switches, 
so the first click selects the date, and the second click de-selects the date.    Each 
selected date increments the frequency counter by 1.
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To Schedule Timed Events

An event that happens at a specific time is a Timed event.    Doctor's appointments, classes, 
and business meetings are examples of Timed events.

Timed events are created and edited using the Timed Event dialog.    The Timed Event dialog
can be accessed from the Timed Event of the Insert menu.    Clicking the  Tool Button, or 
double-clicking any white space below the events that you have scheduled in the Timed 
event area of a planner page also accesses the Timed Event dialog.    It can also be accessed
by clicking the dateline of the event planner page and then clicking the 

, or the New Timed Event icon.    To edit a Timed event that had been previously 
scheduled, double-click the Timed event that is displayed on the planner page.
1.      In the Event Start Date box, specify the start date of the Timed event you are

scheduling.
A Timed event can be scheduled on any given date and time.    The default event date 
displayed is the current date for which you are scheduling an event.    To change the date
displayed, click the Left/Right buttons to change the event date 1 day at a time.    You can
also change this date through the Standard Calendar dialog by clicking the , or the 
Date/Time icon.

2.      In the Event Start Time box, set the start time of the Timed event.
The default event start time is set in the Defaults of the Options menu.
The start time you specify is reflected in the Event Start Time box as well as the Time 
Bar.    To set a time different from the display, click the Left/Right buttons to change the 
time, in increments of 5 minutes.    You can also use the Time Bar to set the start time, 
see To Use the Time Bar.
You can also change this time through the Standard Clock dialog by clicking the , or 
the Date/Time icon.

3.      In the Duration box, set the duration of the event, in hours and minutes.
The default event duration is set in the Defaults of the Options menu.
The event duration you specify is reflected in the Event Duration box as well as the Time 
Bar.    You can modify the duration displayed by clicking the Left/Right buttons.    Each 
click represents a duration increment of 5 minutes.    You can also use the Time Bar to set
the event duration, see To Use the Time Bar.

4.      Click an event icon, or click and drag that event icon onto the Event box 
located on the lower left corner of the dialog.
The Event Icon Bar displays 2 rows and 7 columns of event icons.    The default event 
icons displayed are set in the Defaults of the Options menu.
Each one of the event icons has a corresponding event name, and each icon represents a
Timed event that can be scheduled on a given date and time.

5.      Specify the priority you want to give the event.
The default event priority is set in the Defaults of the Options menu.    To change the 
default priority, click the Priority button to cycle through the priorities of 1, 2 or 3.

6.      Specify the current status of the event.
To indicate the progress of the event, click the Status button to cycle through Scheduled 
(  ), Completed (



), or Canceled (
).

7.      Verify that you have no time conflict with other events.
The Conflict warning button, , becomes active, 
, when an attempt is made to schedule 2 or more Timed events at the same time.    To 

view these conflicting events, click the active Conflict warning button, or 
, and a list of Timed events that have been scheduled will be displayed on the screen.    To

return to the Timed Event dialog, click the Close button.
8.      Enter the event name.

The event name is automatically displayed in the Event Name box when you choose a 
Timed event icon.    Default event names are set up in the Defaults of the Options menu.  
You can, however, edit this text by typing over the text displayed.

9.      Enter any event description notes associated with the event.
You can enter any comments or other details in the Event Notes box by typing the text in
the box.    Click the Up/Down arrows of the scroll bar to view text that are not displayed.

10. In the Event With box, specify the name of the person that will participate in 
this Timed event.
To select the person, click the Down arrow to access a list of all the names taken from the
Address Book and click the name of the person.    You can also manually enter a name of 
up to 51 characters in this box.    To add this entry to your Address Book, click the button 
to the left of the Event With box, and the Address Book dialog will be accessed.    For 
more information, see To Manage Address Book Entries.

11. Provide the location of the Timed event.
To select the event location, click the Down arrow to access a list of available locations 
and click your choice.    You can also enter the location manually.    To add this location to 
your Locations list, click the button to the left of the Event Location box, and the 
Locations dialog will be accessed.    For more information, see To Maintain Locations.

12. You have the option to record a voice annotation, set an alarm, or schedule 
the event as a recurring event.
Use the Voice button to record a voice annotation to the event.    The Voice Annotation 
dialog will be accessed.
Use the Alarm button to set an alarm to provide a reminder of this event.    The Alarm 
dialog will be accessed.
Use the Recur button to schedule this event as a recurring event.    The Recur Event 
dialog will be accessed.

13. Click OK to accept the schedule for the Timed event.
To quit without saving the schedule, click Cancel.
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To Use the Time Bar
The Time Bar in the Timed Event dialog provides yet another mechanism to set up the start 
time and the duration of a Timed event.    It contains scroll arrows, start time, duration, and 
end time which you can use to schedule the Timed event.    The selected start time and 
duration are also reflected in the Start Time and Duration boxes above the Time Bar in the 
Timed Event dialog.

The Time Bar provides a drag and drop interface on a scrollable ruled bar with incremental 
scales of intervals in 5, 15, 30, and 60 minutes.    The smallest ticks denote 5-minute 
intervals, the next larger size denote 15-minute intervals, the next denote 30-minute 
intervals, and the largest ticks denote 1-hour intervals.    All the 1-hour intervals displayed 
are labeled accordingly.    For example, 11:00 am.    If you attempt to drag the entire Start-
Duration-End marker system past one end of the scale, the marker system will stop at that 
end and the scale will continue to scroll in the opposite direction.

If you schedule a Timed event that will last longer than 7 hours, only the Duration marker 
and either the Start marker or the End marker will be displayed on the Time Bar.

Timed events that have been scheduled are indicated on the Time Bar with a solid blue line (
).    Any attempt to schedule subsequent timed events within the duration indicated will 

activate the Conflict warning button 
.    To view these conflicting events, click the active Conflict warning button, or 
, and a list of Timed events that have been scheduled will be displayed on the screen.    To

return to the Timed Event dialog, click the Close button.
1.      Specify the start time of the event.

The Time Bar consists of a drag and drop box that allows you to set the start time of the 
Timed event.    The start time and consequently, the duration, are adjusted by keeping 
the end time constant.    To schedule the start time of the event, click the Start marker, 
drag it to the time desired and drop the marker.

2.      Set the event end time.
The end time and consequently, the duration, are adjusted by keeping the start time 
constant.    To schedule an event end time, click the End marker, drag it to the time 
desired and drop the marker.    While the End marker is being dragged, the other marker, 
which is the Start marker, remains anchored.    This allows the duration to be changed.

3.      If you prefer, you can specify the duration instead of the start and end time 
of the Timed event.
The event duration, in hours and minutes, is indicated in the Duration marker on the 
Time Bar as a drag and drop box that connects the Start Time and End Time markers.    It 
is set by clicking and dragging the Start marker while keeping the End marker anchored, 
or by clicking and dragging the End marker to the desired end time while keeping the 
Start marker constant.
The start time and the end time scheduled for a Timed event can be changed by keeping
the duration constant.    To move the entire event to a new time while keeping the 
duration constant, click and drag the Duration marker until the Start marker reaches the 
desired start time, and drop the marker.    When the Duration marker is moved, the entire
Start-Duration-End marker system is moved, and a new start time as well as a new end 
time will be established.

__________
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To Schedule ToDo Events 

An event that starts on a particular day and ends when it is completed or canceled, 
regardless of how much time has elapsed, is a ToDo event.    By its very nature therefore, a 
ToDo event, if not completed, can be carried over from day to day.    Working on a project, 
paying bills, housecleaning, and shopping are some examples of ToDo events.

ToDo events are created and edited using the ToDo Event dialog.    The ToDo Event dialog can
be accessed from the ToDo Event on the Insert menu.    Clicking the  Tool Button, or 
double-clicking any white space below the events that you have scheduled in the ToDo event
area of a planner page also accesses the ToDo Event dialog.    It can also be accessed by 
clicking the dateline of the event planner page and then clicking the 

, or the New ToDo Event icon.    To edit a ToDo event that had been previously scheduled, 
double-click the ToDo event that is displayed on the planner page.
1.      Determine the date when you want to schedule your ToDo event.

The Standard Calendar, located on the right of the ToDo Event dialog, is used to schedule
ToDo events.
The monthly calendar displays the month and year of the date for which you are 
scheduling an event.    The date today    or the system date of your PlanIt is highlighted in
blue, and the current date for which you are scheduling an event is highlighted in green.  
On the right of the monthly calendar, the 3 months subsequent to the monthly calendar 
are also displayed.    Click the Up/Down arrows on the scroll bar to view months that are 
not currently displayed.
You can change the monthly calendar display by clicking the Left/Right arrows of the 
Month or Year text above the calendar, or you can scroll through the 3-month calendar 
and click the month of the desired year.

2.      Click an event icon and drag that icon onto the desired day on the monthly 
calendar.
The Event Icon Bar displays 2 rows and 7 columns of event icons.    The default event 
icons displayed are set in the Defaults of the Options menu.
Each one of the event icons has a corresponding event name, and each icon represents a
ToDo event that can be scheduled on a given day.

3.      Specify the priority you want to give the event.
The default event priority is set in the Defaults of the Options menu.    To change the 
default priority, click the Priority button to cycle through the priorities of 1, 2 or 3.

4.      Specify the current status of the event.
To indicate the progress of the event, click the Status button to cycle through Scheduled 
(  ), Completed (
), or Canceled (
).

5.      Set the duration of the event, in number of days.
The default event duration is set in the Defaults of the Options menu.    To change the 
default duration, click the Up/Down buttons.    Each click represents a duration increment 
of 1 day.

6.      Enter the event name.



The event name is automatically displayed in the Event Name box when you click a ToDo
event icon and drag it onto a desired day in the monthly calendar.    Default event names 
are set up in the Defaults of the Options menu.    You can, however, edit this text by 
typing over the text displayed.

7.      Enter any event description notes associated with the event.
You can enter any comments or other details in the Event Notes box by typing the text in
the box.    Click the Up/Down arrows of the scroll bar to view text that are not displayed.

8.      You have the option to record a voice annotation or set an alarm for this ToDo
event.
Use the Voice button to record a voice annotation to the event.    The Voice Annotation 
dialog will be accessed.
Use the Alarm button to set an alarm to provide a reminder of this event.    The Alarm 
dialog will be accessed.

9.      Click OK to accept the schedule for the ToDo event.
To quit without saving the schedule, click Cancel.

__________
See also
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To Set the Alarm of an Event

A reminder alarm can be set up to provide advance warning of any event.    Your PlanIt 
comes with a set of assorted media clips (AVI - video, WAV - sound , and EYE - Rosebud eye 
animation) and you can specify the media clip you want to use to play back as the alarm.    
However, you have the option to use other *.AVI or *.WAV files as your alarm clips by loading
them into your system through the Personal Assistant dialog.

An alarm is created and edited using the Alarm dialog.    The Alarm dialog can be accessed 
from any event dialog by clicking the Alarm button.    

You can edit the alarm that has been set for an event any time prior to the occurrence of the
event.    To edit an alarm, double click the event that is displayed on the planner page and 
click the Alarm button from any of the event dialogs.

In the Day, Two Day or ToDo planner views, the Alarm On icon, or , will be displayed on 
the same line the event is displayed for each Timed, Day and ToDo event you schedule in 
your planner that has an alarm set to it.    If no alarm has been set, the Alarm Off icon, or 

, will be displayed on the event line.    Whether an alarm has been set or not, you can click
either of the Alarm icons to access the Alarm dialog.    
1.      Specify the amount of time prior to the occurrence of the event for the alarm 

to provide a warning.
To change the time displayed, click the Up/Down buttons.    The alarm can be set in 5-
minute increments for Timed events, or 1-day increments for Day and ToDo events.
Note    The alarm set for Timed events must occur in the same day as the event itself.

2.      In the Media Clip box, click to highlight the media clip to use as alarm 
reminder.
The Media Clip box lists the media clips currently in your PlanIt directory that you can use
as alarm reminders.    If you have loaded other *.AVI or *.WAV files through the Personal 
Assistant in the Options menu, these files will also be contained in the list.    Click the 
Up/Down arrows of the scroll bar to view and select media clips that are not displayed.    
To view the media clip you have selected, click the Preview button.    The media clip will 
be played back in the media box and you can use the media buttons to control the media
clip during the preview.

PLAY
Starts playback of desired media clip.

STOP
Stops playback of media clip.

PAUSE
Pauses playback, or resumes playback if paused, of media clip.

RECORD
Not used in this dialog.

FAST FWD
Not used in this dialog.

REWIND
Not used in this dialog.
Note    Some sounds and full-motion video are available only with the CD-ROM version of 
the Personal Daily PlanIt.

3.      Click OK to set the alarm.



Click Delete to clear the alarm that had previously been set for the event.    To quit 
without setting or editing the alarm, click Cancel.

__________
See also
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To Set the Date for an Event

The month, day, and year for an event are set using the Standard Calendar dialog.    The 
Standard Calendar dialog can be accessed from the Timed Event dialog by clicking the , 
or the Date/Time icon.    It can also be accessed from the Day Event and ToDo Event dialog 
boxes; it covers the right half of the dialog it is currently associated with.    Clicking the 

 to the right of the Up/Down buttons of the Ending On box in the Recur Event dialog also 
brings up the Standard Calendar dialog.    It can also be accessed from the Print dialog by 
clicking the 

 to the right of the From and To boxes.

The Standard Calendar dialog consists of date icons that correspond to the format of the 
currently selected month and year.    Each of the date icons corresponds to a date numbered 
from 1 to 31, and to a day of the week namely Sun, Mon, Tue, Wed, Thu, Fri, and Sat.    When 
a different month and/or year is selected, the format of the date icons also changes.

To the right of the monthly calendar are month icons that show, by default, the 3 months 
following the currently displayed month.    A vertical scroll bar allows display of any 3 
consecutive months within 3 consecutive years.    You can change which 3 months to display 
by clicking the Up/Down arrows of the scroll bar to scroll one month at a time.    You can also 
click and drag the elevator button to move immediately to any 3 months within the 3 years.  
To page up or down, 3 months at a time, click in the scroll area above or below the elevator 
button, respectively.
1.      Determine the month when you want to schedule your event.

The monthly calendar displays the month and year of the date for which you are 
scheduling an event.    The date today    or the system date of your PlanIt is highlighted in
blue, and the current planner date for which you are scheduling an event is highlighted 
in green.    To change the month displayed, click the Left/Right buttons to the left of the 
month text to change the month 1 month at a time.    Changes in the currently displayed 
planner month correspondingly change the display of the 3-Month Preview section.
You can also use the 3-Month Preview section to change the displayed month.    Scroll 
through the 3-month calendar and click the month of the desired year.    The month 
selected will be displayed as the monthly calendar.

2.      Choose the year when you want to schedule your event.
The default year displayed is the current planner year.    To select a year different from 
the display, click the Left/Right buttons to the left of the year display to change the year, 
in increments of 1 year.    Changes in the currently displayed year will be reflected in the 
3-Month Preview section.    

3.      Specify the date to schedule the event.
To schedule a Day event or a ToDo event on the current planner date, click the event 
icon; or,click the event icon and then drag and drop that event icon onto the selected 
date.    To set the date from the Timed Event dialog, click the desired date and click OK.

The Standard Calendar dialog is also accessed when you use the Goto Date command. 

__________
See also
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To Set the Defaults for Address Book

You have 2 field titles that you can define in your Address Book, and these 2 user-defined 
field titles are set up using the Options - Address Book dialog.    The Options - Address Book 
dialog can be accessed from the Defaults of the Options menu. 
1.      In the User Field 1 box, type in the text title for the first user-defined field.
2.      In the User Field 2 box, type in the text title for the second user-defined field.
3.      Click OK to accept the default settings for the Address Book.

To quit without changing defaults, click Cancel.

__________
See also

To Manage Address Book Entries



To Set the Defaults for Day Events

The default values and the event icons for the Day Event dialog are set using the Options - 
Day Events dialog.    The default values will be used as starting values in the Day Event 
dialog.    The Options - Day Events dialog can be accessed from the Defaults of the Options 
menu. 
1.      Choose the event icons to place on the Event Icon Bar.

From the scrollable list of event icons and event names, click the desired icon, drag it to 
the desired location on the Event Icon Bar, and drop the icon.    Repeat this selection step
until you have chosen all your Day event icons.    The 14 event icons that are displayed in
the Day Event dialog are the icons that are currently selected.
To change the event names associated with each event icon, click the desired icon from 
either the event icon bar or the scrollable list of event icons and type the new event 
name in the Event Name box just below the Event Icon Bar.

2.      In the Duration box, set the default duration for Day events in number of 
days.
The default duration is 1 day.    To change the default duration, click the Up/Down buttons
to increase or decrease the number of days.    Duration can be any number of days from 
1 to 99.

3.      Specify the default reminder alert before Day events, in number of days.
To set the default number of days to remind you of a Day event prior to its occurrence, 
click the Up/Down buttons to increase or decrease the number of days.    Reminder can 
be any number of days from 0 to 99.
A reminder alert for a Day event is used when you click the Alarm button.

4.      Click OK to accept the default settings for Day events.
To quit without changing default settings, click Cancel.

__________
See also
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To Set the Defaults for Timed Events

The default values and the event icons for the Timed Event dialog are set using the Options -
Timed Events dialog.    The default values will be used as starting values in the Timed Event 
dialog.    The Options - Timed Events dialog can be accessed from the Defaults in the Options
menu. 
1.      Choose the event icons to place on the Event Icon Bar.

From the scrollable list of event icons and event names, click the desired icon, drag it to 
the desired location on the Event Icon Bar, and drop the icon.    Repeat this selection step
until you have chosen all your Timed event icons.    The 14 event icons that are displayed
in the Timed Event dialog are the icons that are currently selected.
To change the event names associated with each event icon, click the desired icon from 
from either the event icon bar or the scrollable list of event icons and type the new event
name in the Event Name box just below the Event Icon Bar.

2.      Specify the default start time for Timed events.
To change the default start time, click the Up/Down buttons to increase or decrease the 
time in increments of 5 minutes, from midnight (00:00) to 11:55pm.

3.      In the Duration box, set the default duration for Timed events in hours and 
minutes.
To set the default duration, click the Up/Down buttons to increase or decrease the time, 
in increments of 5 minutes, from 00:00 to 23:55.

The Timed event must start and end in the same day; that is the start time plus duration 
must be less than midnight.

4.      Specify the default reminder alert before Timed events, in hours and 
minutes.
To set the default time to remind you of a Timed event prior to its occurrence, click the 
Up/Down buttons to increase or decrease the alert time, in increments of 5 minutes, from
00:00 to 23:55.
A reminder alert for a Timed event is used when you click the Alarm button, and it must 
occur in the same day as the actual event.

5.      Set the default priority that you want to give to Timed events.
To set the default priority value, click the Priority button to cycle through the priorities of 
1, 2, or 3 and stop at the desired value.

6.      Click OK to accept the default settings for Timed events.
To quit without changing default settings, click Cancel.

__________
See also

To Schedule Timed Events



To Set the Defaults for ToDo Events

The default values and the event icons for the ToDo Event dialog are set using the Options - 
ToDo Events dialog.    The default values will be used as starting values in the ToDo Event 
dialog.    The Options - ToDo Events dialog can be accessed from the Defaults in the Options 
menu. 
1.      Choose the event icons to place on the Event Icon Bar.

From the scrollable list of event icons and event names, click the desired icon, drag it to 
the desired location on the Event Icon Bar, and drop the icon.    Repeat this selection step
until you have chosen all your ToDo event icons.    The 14 event icons that are displayed 
in the ToDo Event dialog are the icons that are currently selected.
To change the event names associated with each event icon, click the desired icon from 
from either the event icon bar or the scrollable list of event icons and type the new event
name in the Event Name box just below the Event Icon Bar.

2.      In the Duration box, set the default duration for ToDo events, in number of 
days.
To set the default number of days ToDo events should last, click the Up/Down buttons to 
increase or decrease the number of days.    A ToDo event duration can be any number of 
days from 1 to 99.

3.      Specify the default reminder alert before ToDo events, in number of days.
To set the default number of days to remind you of a ToDo event prior to its occurrence, 
click the Up/Down buttons to increase or decrease the alert number of days.    Reminder 
can be any number of days from 0 to 99.
A reminder alert for a ToDo event is used when you click the Alarm button.

4.      Set the default priority that you want to give to ToDo events.
To set the default priority value, click the Priority button to cycle through the priorities of 
1, 2, or 3 and stop at the desired value.

5.      Click OK to accept the default settings for ToDo events.
To quit without changing default settings, click Cancel.

__________
See also

To Schedule ToDo Events



To Set the Start Time for an Event

The start time for an event is set using the Standard Clock dialog.    It can be accessed from 
the Timed Event dialog by clicking the , or the Date/Time icon.    The Standard Clock 
dialog covers the left half of the dialog it is currently associated with, usually the Standard 
Calendar dialog.
1.      Set the hour portion of the event using either the analog clock face or the 

Event Time box.
The clock displays 12 hours around an analog clock face, in 1-hour increments.    A 
needle points to the selected hour.    To select an hour for the Timed event, click the 
desired hour on the clock face.    You can also click and drag the clock needle to the 
desired hour.    The hour you select is also reflected in the Event Time box.
The Event Time box displays the time of the event.    To change the time displayed, click 
the Left/Right buttons to set the time, in increments of 5 minutes.    The time you specify 
is reflected in the event clocks and the am/pm switch.

2.      Specify the minutes portion of the event using either the analog clock face or
the Event Time box.
The clock displays 60 minutes, in 5-minute increments, around an analog clock face.    A 
needle points to the selected minutes.    To select the minutes for the Timed event, click 
the desired minutes on the clock face.    You can also click and drag the clock needle to 
the desired minutes.    The selected minutes are also reflected in the Event Time box.

3.      Indicate whether A.M. (before noon) or P.M. (after noon).
To select whether the selected time refers to before noon or after noon, click the am/pm 
toggle switch.    The switch toggles between A.M. and P.M.    The selected setting is also 
reflected in the Event Time box.

4.      Click OK to set the time.
To quit without setting the time, click Cancel.

__________
See also

To Schedule Timed Events



To Configure Page Settings to Print

Page settings used to print information are set up using the Page Setup dialog.    You can 
choose from a pre-defined list of page layouts, edit a layout from the list, or create a new 
layout.    A page layout for the print output can be customized by setting the size, 
orientation, margins, and font type, sizes and styles.    
1.      From the File menu, choose Page Setup,

- or -
If you are in the Print dialog box, click the Page button.

2.      In the Layout box, indicate the paper layout of the output.
The Standard Layout is the default layout.    To select a different layout, click the Down 
arrow to access a list of page layouts, and click the desired paper layout. Numbers in 
parenthesis for label  orientations indicate the corresponding Avery    Dennison Laser 
Product part number(s).    To create a new layout, type the new page layout title in the 
box. 

3.      Specify the paper orientation to use.
Click one of the available orientations:

Portrait 
Landscape
Labels
Envelope

Note: Labels orientation cannot be selected but rather indicates when you have selected
a pre-defined label oriented layout.

4.      Specify the top, bottom, left, and right margins.
Click the Up/Down buttons in each of the top, bottom, left, and right boxes to increase or 
decrease the margins in increments of 0.1 inch. Margins may not be edited for Label 
orientations.

5.      Specify the paper width in inches.
The default paper size is 8.5 by 11.    To change the paper width, click the Up/Down 
buttons to increase or decrease the width in increments of 0.1 inch. Page Width may not 
be edited for Label orientations.

6.      Specify the paper height in inches.
The default paper size is 8.5 by 11.    To set the paper height, click the Up/Down buttons 
to increase or decrease the height in increments of 0.1 inch. Page Height may not be 
edited for Label orientations.

7.      In the Font box, select the font type to use on the printed output.
The font types shown are those that are available for the currently selected printer.    To 
change the font type displayed, click the Down arrow to access the list of available font 
types for the selected printer and click the desired font type.

8.      Specify the font sizes for the page heading, title, and text to be printed.    
To change the font sizes displayed, click the Up/Down buttons of the corresponding page 
heading, title, and text font settings to increase or decrease the font sizes.

Page Heading is specified in the Print Options and is printed centered at the top of each



page.    Page Heading font size and style is not used when printing label or envelope 
orientations.

Title refers to the date line when printing Planner or ToDo List sections. Title refers to 
the first line (Name or Company) when printing Address Book sections.

Text refers all information not printed as Heading or Title; this is the event information 
after the date line when printing Planner or ToDo List sections and the information after 
the first line (Name or Company) when printing the Address Book section and all Location
information.

9.      Specify the font styles for the page heading and title to be printed.
Click the desired font styles from the following:

Bold 
Italics
Underline 

You can use any combination of these styles.
10. Click OK to accept page settings.

To quit without editing page settings, click Cancel.    To erase the page setup, click 
Delete.

__________
See also

To Print from Your PlanIt



To Set Up Print Options

The information to be included on the output is specified using the Print Options dialog.
1.      From the File menu, choose Print Options,

- or -
If you are in the Print dialog box, click the Options button.

2.      Set up print options for the different sections.
The print sections available are:

Planner
Address Book
ToDo List

3.      Click OK to accept print options.
To quit without changing print options, click Cancel.

__________
See also

To Print from Your PlanIt



To Set Up Print Options - Address Book

1.      In the heading box, enter the text to be used as heading for the Address 
Book printout.

2.      Select the information to include in the printout.
Click the boxes next to the desired information.    The fields available are:

Title
First Name
Last Name
Company
Position
Address
Telephone
Fax
User 1
User 2
Notes

3.      For Notes, specify the level of detail to be printed by clicking either All or # 
Lines.    
All includes all Notes.    The # Lines sets the number of lines to be printed for the Notes in
the Address Book printout.    To change the number of lines, click the Up/Down buttons to 
increase or decrease the number of lines in increments of 1.

__________
See also

To Print from Your PlanIt
To Set Up Print Options - Planner
To Set Up Print Options - ToDo



To Set Up Print Options - Planner

1.      In the Heading box, type in the text to be used as heading for the Planner 
printout.

2.      Indicate the events to be included in the Planner printout
The types of events available for the Planner printout are:

Timed Events
Day Events
ToDo Events

To select an event type to be printed, click the box of the appropriate event. 
3.      Specify the level of detail to include in the printout by clicking either the Full 

Detail or # Lines button.
The Full Detail includes all event information in the Planner printout.    The # Lines sets 
the number of lines to be printed for each event in the Planner printout.    To change the 
number of lines per event, click the Up/Down buttons to increase or decrease the 
number of lines in increments of 1.

__________
See also

To Print from Your PlanIt
To Set Up Print Options - Address
To Set Up Print Options - ToDo



To Set Up Print Options - ToDo List

1.      In the heading box, type in the text to be used as heading in the ToDo 
printout.

2.      Indicate whether to include incomplete ToDo events as well as canceled ToDo 
events in the printout.
To include incomplete and canceled ToDo event types, click the boxes next to these ToDo 
event types.

3.      Specify the level of detail to include in the ToDo event printout by clicking 
either the Full Detail or # Lines button.
The Full Detail includes all event information in the ToDo printout.    The # Lines sets the 
number of lines for each event to be printed in the ToDo printout.    To change the number
of lines, click the Up/Down buttons to increase or decrease the number of lines in 
increments of 1.

__________
See also

To Print from Your PlanIt
To Set Up Print Options - Address
To Set Up Print Options - Planner



To Purge Events and Voice Files

Events that you have scheduled into your PlanIt, as well as the voice annotation files that 
have been recorded to these events, can be purged from your system at any time to provide
additional disk space.

The Purge Events dialog consists of purge options that allow you to specify the type of files 
to purge.    To its right is the Standard Calendar which you can use to specify the date prior to
which events and voice files will be purged.    To access the Purge Events dialog, choose the 
Purge Events from the Edit menu.
1.      Specify the files you want to purge.

To remove all events and the corresponding voice annotation files, click the All Events 
button.    All the events and voice files that have been scheduled prior to the date you 
specify will be purged from your system.
To delete completed and canceled events and voice files, click the Completed/Canceled 
button.    Events that have not been completed or canceled will not be purged from your 
system.
To remove only the voice annotation files, click the Voice Files Only button.    The event 
files will not be purged from your system.

2.      Determine the month of the purge date.
The monthly calendar displays the month and year of the current planner date.    The 
date today or the system date of your PlanIt is highlighted in blue, and the current 
planner date is highlighted in green.    To change the month displayed, click the Left/Right
buttons to the left of the month text to change the month 1 month at a time.    Changes 
in the currently displayed planner month correspondingly change the display of the 3-
Month Preview section.
You can also use the 3-Month Preview section to change the month displayed.    Scroll 
through the 3-month calendar and click the month of the desired year.    The month 
selected will be displayed as the monthly calendar.

3.      Specify the year of the purge date.
The default year displayed is the current planner year.    To select a year different from 
the display, click the Left/Right buttons to the left of the year display to change the year, 
in increments of 1 year.    Changes in the currently displayed planner year will also be 
reflected in the 3-Month Preview section.    

4.      In the monthly calendar, click the date prior to which the files will be purged.
The date selected will be displayed in the Remove Before box.    Specified files dated 
before this date will be purged from your system.

5.      Click OK to purge the files as indicated.
To quit without purging the files, click Cancel.

__________
See also

To Navigate with Goto Commands
To Set the Date for an Event



Media Buttons

All video clips, including the alarm clips and the PlanIt Quick Tour, are displayed in the media
box.    You use the media buttons to control the media clip displayed in the media box.    You 
also use the media buttons when you record and edit a voice annotation sequence.

PLAY
Starts playback of media clip.

STOP
Stops playback of media clip.

PAUSE
Pauses playback, or resumes playback if paused, of media clip.

FAST FWD
Quickly forwards to the end of the media clip.

REWIND
Rewinds to the beginning of the media clip. 

RECORD
Starts recording.    This button is used when you record a voice annotation sequence to an 
event.
Note    Some sounds and full-motion video are available only with the CD-ROM version of 
the Personal Daily PlanIt.    

__________
See also

To Launch Programs and Entertainment
To Record Voice Annotation to an Event
To Set the Alarm of an Event



Tool Buttons

Tool buttons are buttons that automate the frequently used commands in your PlanIt.    To 
use Tool Buttons, position your mouse pointer on the tool icon and click the left button of 
your mouse.

      File New
Creates a new file.

      File Open
Opens an existing file.

      File Save As
Saves the current file.

      File Print
Prints information from your PlanIt.

      Edit Cut
Removes selected event and puts it on the Windows Clipboard.

      Edit Copy
Copies the selected event onto the Windows Clipboard.

      Edit Paste
Inserts a copy of the contents stored in the Windows Clipboard at the cursor position.

      Edit Delete
Deletes the selected event without saving it to the Windows Clipboard.

      Goto Date
Takes you to the date you specify.

      Goto Today
Goes directly to today's date.    The date today is the system date of your PlanIt.    In the 
planner sections that display more than one day, the date today will be highlighted in blue.

      View Month
Displays a calendar for the current month, with the date today highlighted in blue.

      View Year
Displays a calendar for the current year, with the date today highlighted in blue.

      Insert Timed Event
Creates a Timed Event. 

      Insert ToDo Event
Creates a ToDo Event.

      Insert Day Event
Creates a Day Event.

      Insert Address
Creates an entry in the Address Book.



      Alarm
Edits the alarm of an event before its occurrence.

      Maximize/Normal View
Determines the display mode of your PlanIt window.

      Help
Accesses the on-line help information.

__________
See also

To Configure Tool Buttons
To Manage Address Book Entries
To Schedule Day Events
To Schedule Timed Events
To Schedule ToDo Events
To Set the Alarm of an Event
To Set the Date for an Event



To Update Media

At the beginning of each month, you will be prompted to update the media contents of your 
hard disk from your PlanIt CD-ROM.    You can keep the media contents that you currently 
have in your hard disk if you do not proceed with the update.    However, if you proceed with 
the update, the media contents in your hard disk will be replaced by the media contents 
from the CD-ROM for the month that you specify.

You can also update your media contents at any time other than the beginning of the month 
by accessing the Update Media command from the File menu.

Your media contents are updated using the Update Media dialog.
1.      Specify the month for which the media contents will be updated.

Click the Down arrow to access a list of months and click the month you want to update 
the media contents for.

2.      Specify the media contents to update.
To update images, click the Update Images check box.    An 'X' in the Update Images box 
indicates that the images in your hard disk will be updated.    Click the check box again 
and the 'X' will disappear, indicating that your images will not be updated.    If you also 
want to update the large images that you currently have, click the Include Large Images 
check box.    Images are updated only for the current PlanIt image pack.
To update your entertainment features, click the Update Entertainment check box.    
Entertainment features are updated based upon your current launcher button settings.

3.      Click OK to update the media contents in your hard disk.
To quit without updating media, click Cancel.



To Change System Date and Time

The system date of your PlanIt is the date today, and the system time is the time now.    The 
system date and time can be changed through the Edit Date/Time of the Edit menu.    The 
Standard Calendar dialog with the date and time change options attached to its left will be 
accessed.
1.      Determine the month of the date you want to change to.

The monthly calendar displays the current month and year with the date today 
highlighted in blue.    To select a month different from the current month, click the 
Left/Right buttons to the left of the month text to change the month, 1 month at a time.   
Changes in the monthly calendar correspondingly change the display of the 3-Month 
Preview section.
You can also use the 3-Month Preview section to change the monthly calendar.    Scroll 
through the 3-month calendar and click the month of the desired year.    The month 
selected will be displayed as the monthly calendar.

2.      Choose the year of the desired date.
The year displayed is the current year.    To select a year different from the display, click 
the Left/Right buttons to the left of the year display to change the year, in increments of 
1 year.    Changes in the currently displayed year will be reflected in the 3-Month Preview 
section.    

3.      In the monthly calendar, click the date to change to.
The date selected will be displayed in the box to the left of the Standard Calendar dialog.

4.      Specify the time to change to.
The system time displayed is the time now.    To change the system time, click the 
Left/Right buttons to decrease or increase the number of hours, minutes, or seconds 
accordingly.

5.      Click OK to change the system date and time.
To quit without changing the date and time of your PlanIt, click Cancel.

__________
See also

To Set the Date for an Event



To Import A Text File

The PlanIt allows you to import external text files (also known as comma separated value, or
CSV, files) into the address book section of your current PlanIt database file.    To access the 
Import Text File dialog, click File Import    from the PlanIt menu.

The File Import Mapping dialog box contains the following options.    When you are finished, 
click OK to import files, or click Cancel to quit without importing files.

1.      Choose the text file to import.
After choosing File Import - Address book from text file, select the desired file and 
click OK.    The selected Import from path and file name is displayed at the top of the 
dialog.

2.      Indicate whether the text file includes the field names.
If the first record in the text file contains the field names, click the Field names as first 
record check box. An X in this check box indicates that the text file contains field names 
as the first record and therefore this record should not be imported.    Click the check box 
again and the X will disappear, indicating that the first record will be imported along with
the rest of the text file.

3.      Map the text file fields to the PlanIt fields.
To map a text file field to the PlanIt field,    click the desired PlanIt field and then click the 
corresponding text file field.    The text file field number or data, depending on which 
Display option is selected (see below), will appear next to the selected PlanIt field.    To 
clear a text file field mapping to a particular PlanIt field, click on the text file field again.   
You may map multiple text file fields to each PlanIt field by clicking on the desired text 
file fields.    Use the scroll bar to scroll to fields not displayed in either the Text File 
Fields list box or the PlanIt Fields list box.

Note:  Each text file field may only be mapped to one PlanIt field, but multiple text file 
fields may be mapped to each PlanIt field. 

Clicking Map All will map the first text file field to the first PlanIt field, the second text 
file field to the second PlanIt field,    and so forth until all PlanIt fields have been mapped 
to one of the text file fields.
Clicking Clear will clear all mappings between the PlanIt fields and the text file fields.

4.      Display the text file data next to the PlanIt field names.
Click the Display: Data radio button to display the text file data next to the mapped 
PlanIt fields.    A filled circle within the radio button indicates it has been selected, 
otherwise the radio button is blank. To switch back to displaying the Field Names next to 
the mapped PlanIt fields, click the radio button next to Field Names.    

Note: No information is displayed until fields from the Text File Fields list box are 
mapped to the fields in the PlanIt Fields list box.

3.      Click OK to import the data from the text file into your PlanIt address book.
To quit without importing data, click Cancel.



To Export To A Text File

The PlanIt allows you to export the PlanIt address book to external text files (also known as 
comma separated value, or CSV, files).    To access the File Export Mapping dialog, click File 
Export    from the PlanIt menu.

The File Export Mapping dialog box contains the following options.    When you are finished, 
click OK to export to the selected file, or click Cancel to quit without exporting.

1.      Choose the text file to export to.
After choosing File Export - Address book to text file, select the desired file and click
OK.    The selected Export to path and file name is displayed at the top of the dialog.

2.      Indicate whether the text file will include the field names.
If the first record in the text file should contain the field names, click the Field names 
as first record check box. An X in this check box indicates that the text file will contain 
the mapped PlanIt field names as the first record.    Click the check box again and the X 
will disappear, indicating that the PlanIt field names will not be written to the text file.

3.      Map the text file fields to the PlanIt fields.
To map a PlanIt file field to a text file field,    click the desired text file field and then click 
the corresponding PlanIt field.    The PlanIt field name or PlanIt data, depending on which 
Display option is selected (see below), will appear next to the selected text file field.    To
clear a PlanIt field mapping to a particular text file field, click on the PlanIt field again.    
You may map multiple PlanIt fields to each text file field by clicking on the desired PlanIt 
fields.    Use the scroll bar to scroll to fields not displayed in either the Text File Fields 
list box or the PlanIt Fields list box.

Note:  Each PlanIt field may only be mapped to one text file field, but multiple PlanIt 
fields may be mapped to each text file field. 

Clicking Map All will map the first text file field to the first PlanIt field, the second text 
file field to the second PlanIt field,    and so forth until all PlanIt fields have been mapped 
to one of the text file fields.
Clicking Clear will clear all mappings between the PlanIt fields and the text file fields.

4.      Display the text file data next to the PlanIt field names.
Click the Display: Data radio button to display the PlanIt data next to the mapped text 
file fields.    A filled circle within the radio button indicates it has been selected, otherwise
the radio button is blank. To switch back to displaying the Field Names next to the 
mapped text file fields, click the radio button next to Field Names.    

Note: No information is displayed next to the text file fields until fields from the Text 
File Fields list box are mapped to the fields in the PlanIt Fields list box.

3.      Click OK to export the data from your PlanIt address book into the text file.
To quit without exporting data, click Cancel.




